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Introduction

Maplytics™ is a leading Certified for Microsoft Dynamics 365 (CfMD) geo-analytical mapping app.
Maplytics empowers users across verticals with the power of Geographical Data Visualization, Optimized
Routing, Automated Appointment Planning, Proximity Search, Heat Maps, Shape Overlay, Census data
visualization and Territory Management to drive better sales, improve business processes and engage
right customers at the right time.

Maplytics is available for Microsoft Dynamics versions CRM 2013 and above and supports all deployment
models of CRM On-Premise (IFD as well), CRM Online and Partner-hosted. It uses the APl services provided

by Bing maps. The following are the highlights of Maplytics:

N N N N N R N N N N N N N N N S N N N N NN

@il‘lDEiC

Ease of access

Multiple language support

Plot any entity record on the map

Area of Service

Proximity Search

Auto Scheduling

Territory Management

Check-In

Bring your own icons

Multiple category on plot card

Multiple territory for a record

Spider Cluster

Building Marketing list

Pie Charts and Column Charts in Heat Map
Overlay

Merged Plot and Route view

Maplytics Security Template

Point of Interest search

Layer Menu

Concentric Proximity search

Bulk geographies upload

Shape operations

CRM / Dynamics 365 Customer Engagement
View travel distance on proximity search

innovative logic

AN NN NN

ASRNENIEN

< S

ﬁo MAPLYTICS™

PowerApps Component Framework
Census data visualization

Support for CDS

Data grid resizable

Plot Saved Templates on individual records
Color coding of pushpins based on
configurable categorizations

Routing with multiple waypoints

Along the Route search

Ability to Save & Share Driving directions
Sales analysis made easy with Opportunity
and Sales Heat Maps

Summary Card on Detail and Heat Map
Configurable color for Heat Map measure
Include Maplytics component on the
Dashboard through configurable queries
Geocoding Confidence Rating

Compatibility with Dynamics 365 App for
Phones and Tablets

Route Redirect for turn by turn navigation on
mobiles and tablets

Seamlessly integrated within Dynamics

Check-In

Page 6 of 145




Maplytics™ — User Manual

Language Support

Maplytics is a multi-language solution currently available in six different languages namely:

e English

e Spanish (Espafiol)

e German (Deutsche)

e French (Frangais)

e Portuguese (Portugués)
e  Turkish (Tirk)

Set Personal Options

Change the default display settings to personalize Microsoft Dynamics 365, and manage your email templates.

General | Synchronization | Activities | Formats | Email Templates

Select the language you prefer to

hange the display lan

Maplytics auto-detects the user language
set in Dynamics CRM and sets its
language accordingly.

To check user language set in Dynamics
CRM, please go to Settings > Options >
Languages

Maplytics Configuration (Personalization)

Each user of Maplytics can customize Maplytics configuration according to their preference. The user can
configure Zoom level, Current Location, default origin and destination and a couple of other settings like
Map more, default summary grouping, etc. Please go to Settings > Maplytics Configuration Details >
Select Maplytics Configuration record for the required user (users added in Team Maplytics)> Set

according to the preference

Refer to ‘Maplytics Configuration Details (Personalization)’ section of Installation Manual for a detailed

description of personalization settings.

) innavative logic
@il‘IDEiC
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Maplytics Security Template

System admin and Maplytics admin can provide selective access of Maplytics actions to the Maplytics
users. They can select the relevant Mass actions & other actions and provide the access of the same to
the respective Maplytics users on the map.

Go to the Settings > Maplytics > Maplytics Security Templates > New

= B2 show Chart il Delete | v () Refresh %) Email a Link | ~ o Flow ™~ fill Run Report B3 Excel Templates B3 Export to Excel N

Dynamics 365 ~

fy Home
i I 1 v Se ecord: L
— . B Active Maplytics Security Templates .
7 Pinned v
v Name T Add..TL Aut.. TL Cha..TL Cre.. TL Cre.. T Cre.. TL Cre.. T Do.. Tl Exe... T
Maplytics
Field Sal N N N N N | ] == e N
Maplytics Dashboard... e eaes ° © © © © & °
Bl entity Maps Marketing No No No No No ] No No
] Maplytics Templates
B Maplytics Configurat...
| B Maplytics Security Te..
& License Registration
B Teritories
A Teams
Bl Routes
»
palll # A B C D E F & H 1 J K L M N o P Q R 5 T u v W X Y z
View records that start with this etter
1-20f 2 (0 selected)
H Settings o]

Go to General and provide a name for the template. Under the section of Maplytics Configuration Details,
add the Maplytics Configuration Detail records of the Maplytics users whom the created template has to
be assigned.

MAPLYTICS SECURITY TEMPLATES
Field Sales

General Action Configuration  Related
Name " Field Sales Maplytics Configuration Details
v User T | Product Name T | Distan.. T

Peter Asht. Maplytics Mile

John Parke Maplytics Mile
3

) innavative logic ™
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Go to Action Configuration > Select the required actions to be made available to the users selected

Actions

B Ade N — B sne
To remove the users from the list, Go to Settings > Maplytics Configuration Details > Select the record of
the required user> Remove the lookup value for the field of ‘Maplytics Security Templates’

o Maplytics
General Auto Scheduling  Related
Distance Unit Mile Along The Route 500
Distance .
Optimize Direction Mo Default Location ===
Live Traffic No Records Per Page In
Grid 50
Route Option Shortest Time - »
Zoom Level -
) Map Cente
=P e B User © 0 Peter Ashton
Heat Map Type Bound ftics 5 ity
oundary :larv;::z};l:: Security [ Field saes
Summary Grouping City
Set As Destination None
Default Template
Set As Origin None
Ly
=} Active Status:  Active Save
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Note:
o All the actions will be visible to a user, if no template is assigned to the user
e Only System Admin and Maplytics Admin will be able to access the Maplytics Security Template
Entity

Individual Record Map

A tab to display an Individual Map section has been added by default on the Account, Contact and Lead
records as a part of the Maplytics solution.

venue No. of Employees

ACCOUNT
° A. HANSA PERSAUD & SONS

Summary Tab Map Project Price Lists Details Field Service  Scheduling Related

R s 7 i ¥ Richmond
No Auto Geocoding Yes -, jdressQ [ Lat/Long Update -R I I ¢'§ o B
Freshkills Par
!\' : } éj . @ contact_customer_accounts|
AAAAAA A & RESH K La Tourette
Street 1 private bag 10306 od] F 4 Park e 7
“ 4 & View
- 4 S bl A Cemetery
s z
3 5
Sewaren Arthur Kill ;
x
cef 3
B » ills Park
s> Great Kills Par
Boynton Beach \g
&
Citv
City Staten Island Great Kills
I\‘pnns WOODROW Harbor
on | Greel
State/Province NY c LESTON
Barber ¥ ot
ZIP/Postal Code 2 _all
P 3 10309 B inces Ay
Country/Region USA ado} Ourerbrigge Crosing
Wolfe
Pond
Latitude 40.54336 i Park
6
Longitude -74.20697
Perth Amboy 2500 feet Sk
s seie e -
Territory [T New york post... pBing © 2015 HERE, ©.2016 Microsor Corparation Terme

Here, two types of pushpins are plotted on the map:
e Orange color pushpin:
This always indicates the record location on the map. This pushpin is movable on the map. If the
user is not satisfied with the automatic geocoding information stored for the record, they can
manually move the pushpin to the exact location of their choice. As the user moves the pushpin,
the geocoding information (Latitude and Longitude) is updated in the bar at the top. Use the
Update button to save the updated geocoding information.

If the application is not able to geocode the address provided, the user can edit the address in the
Address text box and click on Search button. This will help the user to geocode the address.

Set the ‘No Auto Geocoding’ option to ‘Yes’ available on the left-hand side, if the user has manually
set the geocoding information and do not want the automation to override the geocoding
information.

(o) &P MapLYTICS™ Page 10 of 145
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e Related Record Pushpin:
The related records are indicated by star pushpins. Related records correspond to all 1:N
relationship between the plotted Entity and the user can set a default relationship which should
always be plotted whenever this map is loaded. The user can further see related record
information by clicking on it. The user can plot maximum two relationships here. The user can use
‘Relations’ drop-down to select the available relationships for this Entity. Check the Entity Map
settings (refer to Installation Manual) to set Default relationship and adding more relationships
to ‘Relations’ dropdown.

: Ay Microsoft Dynamics CRM
Steps to add the Map to other entity e[| ]
. v ¥ v ¥ ¥ ¥ 3 3 __@ Wb Resaurce
forms: S mm 0O OB = o
TN e Colimns Comns Cotimns Colns Coomn o SRS T s e e
Open the Entity form and go to the ‘Insert’ M Contms Colimws Coms Cous Coimrs Coumn e s
3 Tabs 2Tabs 1Tab Control
ta b 4 Opportunity Solution: Default Solution Web Resource
Summary Form: Opportunity ’Ad/d an existing Web resource to this
Click on ‘Web Resource’ button, as shown e py— ——
in the Screenshot. Quotes | | rTTTTTITTITIIIIII :;T:;Zr\nmbs named and formatted ||
2] Add Web Resource -- Webpage Dialog H
Add Web Resource , In the Add Web Resource dialog, select
Add an existing web resource to the Form. ”ikl_/quIytics/MapIytics'IndiViduaIMGP'html”
web resource and check the Pass record object-
General  Formatting  Dependencies .
— type checkbox as shown in the screenshot.
Web resource * @] iKl_/Mapiytics/Maplytics.Individual Map.htm| z jﬂ
Click OK, then Save and publish the form to see
Field Name and Properties .
Mo r— v l the Map on the entity form.
Label * Map |
[[IDisplay label an the Form
Visibility
W] visible by default
Web Resource Properties
Custom Parameter(data)
[H] Restrict cross-frame scripting, where supported.
E Pass record object-type code and unigue identifier as parameters.
QK Cancel

Note: To plot a particular address on the Map, it should be geocoded and the Latitude & Longitude
should be set for that address. For geocoding you need to execute Maplytics Geocoding workflow for
the records.

@.—,DE.& &P mapLYTICS" Page 11 of 145
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Area of Service

The user can view the data in a proximity or a region around an individual record as defined by the user
in the Area of service.

Summary Map Areaof Service Accounting Details Details  Versium Predict Insights  Project Price Lists  Linkedin Company Profile ~ General  Partner Program

Area of Service

@pLor Srol o . R

Freshiifs Park
Search Option

- ] 7
Proximity v Layer Menu i
Proximity
® Distance @ Time | !
12 Miles v & Cluster map :
‘ a Search Option

Select Datasource By Location v
Account v Accounts - Staten isla ¥ MY Current Location

4364 at ARTHUR KILL ROAD Staten Islanc | @
Proximity Awinone
® Distance © Time
™~ Show Travel Distance

12 Miles *

Select Datasource

Add Area of Service tab
To add Area of Service tab, Open the Entity form and go vove [ser]
to the ‘Insert’ tab. Click on Web Resource button, as ; min oo O &B= B8

. — Il L = : =l | = o G rrave
shown in the screenshot. e o Cobos Comod | i UG s QRN e o
3 Tabs 2Tabs 1Tab
Add Web Resource 7 x .
Add an existing web resource to the Form. In the Add Web Resource dia IOg, select
“ikl_/Maplytics/Maplytics.AutoSearchFilters.ht
PR pr——— . S——— - ml” web resource and check the ‘Pass record

~Web resource

object-type’ checkbox.

Web resource ® 8 ikl_/Maplytics/Maplytics.AutoSearchFilters.t [

The preferred number of rows in formatting is 15.

r—Figld Mame and Properties

Name * WebResource. [area of senvics |

- oo ‘ Click OK, then Save and publish the form to see
U Display label on the Form the Map on the ent|ty form.

— Visibility

) visible by default

¥ Enabile for mobile

&

—Web Resource Properties
Custom Parameter{data)

Restrict cross-frame scripting, where supported

{0

Pass record object-type code and unigue identifier as parameters.
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Create an Area of Service field

To save the values entered in the Area of Service, the user needs to create a field for the Entity for which
Area of Service has been added. Go to Entity form > New field. Enter the following values:

Name - Area of Service

Data type — Multiple Line of Text

Maximum Length — 10000

Select the field in the respective Entity map for the Area of Service field.

ENTITY MAP
account

General  Attribute Mappings Tooltip Mapping  Category Configuration  Configuration  Advance Settings  Related

Title ® [ Account Name | Area of Service [ Area of Service

Template

The values when entered and saved into the Area of Service, the corresponding data will be plotted on
the map.

View Area of Service data on a map
To view the Area of Service data on the map, there are two ways:

e Using Map button —the results are shown in a map opened in a different tab
e Adding Detail map on form — the results are shown in a map added on the same record

Using Map button

The user can open the Detail map to view the corresponding Area of Service data plotted on the map.

(6] T New 5 Open Org Chart [‘&. Deactivate A Connect N < Addto Marketing List A, Assign CZl Email a Link ]E Delete O Refresh

ACCOUNT Annual Revenue No. of Employees
A. HANSA PERSAUD & SONS 366,466.00
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Adding Detail map on form

To add a Detail map to show the data of Area of h Home _|[liNserT lﬁ

f

= (oo [8o0 ()| (S (B

Service, follow the steps mentioned below:

Open the Entity form and go to the ‘Insert’ tab. Section _Three  Three Two Two Two
-~ Columns Cclumns olumns jColumns Columns
Add two columns.
3 Tabs 2 Tabs

Web Resource Properties % X
Modify this Web resource’s properties,

After adding Area of Service tab in the entity form
as mentioned above, follow the steps mentioned
below to add the Detail map on the entity form.

Genaral Formatiing Dependencias

—~Web resourcs

Wes resource ® @ ii_Maplytics/Maplytics DetailMap.htmi 0§
To add a detail map, Click on ‘Web Resource’ —Fisld Name and Properties
button. In the Add Web Resource dialog, select e
“ikl_/Maplytics/Maplytics.DetailMap.html” WA =
web resource, add “form” as custom parameter
(data) and check the ‘Pass record object-type’ —Visibility
checkbox as shown in the screenshot. The <

@ Eravie tor mobie

preferred number of rows in formatting is 15.

—Web Resource Properties

form

Custom Parameter{data)

Res crozz-frame scrpting where supported.

Click OK, then Save and publish the form to see = i A e G I

the Map on the Entity form.
P Y

Enter the required values into Area of Service, save it and click on the refresh button on the Detail map to
view the data plotted.

Summary Map Areaof Service Accounting Details  Details  Versium Predict Insights ~ Project Price Lists  Linkedin Company Profile  General  Partner Program

Area of Service

@pLOT &ro of DIRECTION  § L jid
Search Option g 3
Proximity v . Layer Menu
Proximity =

® Distance © Time [
Me

12 Miles v Cluster map
a Search Option

Select Datasource By Location v

Account v Accounts - Staten isla ¥ WY  Current Location

4864 3t ARTHUR KILL ROAD Staten Islanc | (@

=] Broximity AMNADALE
® Distance © Time
™~ Show Travel Distance
1.2 Miles v

Select Datasource

@an‘&‘i“:“&“ 6@ MAPLYTICS™ Page 14 of 145
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Detail Map

Maplytics buttons are added to the Entity forms as well as the Entity Homepages so that it can be easily
accessed from anywhere.

[©) T New Ega Open Org Chart [‘é Deactivate pﬁ Connect N % Addto Marketing List R—) Assign [Z] Email 2 Link IEI Delete O Refresh

ACCOUNT Annual Revenue No. of Employees
A. HANSA PERSAUD & SONS 366,466.00 e

Summary Tab Map Project Price Lists  Details  Field Service  Scheduling  Related

ACCOUNT INFORMATION Timeline -+ Primary Contact

Account Name N ]

A, HANSA PERSAUD 8 SONS CONTACTS

Using this button, the user can invoke the Maplytics application for detailed geographical analysis.
Maplytics provides both ‘Heat Maps’ view as well as ‘Detail Map’ view of the Dynamics CRM data. These
views can be easily accessed from the buttons added to the command bar in entity home pages and

other views.
@ Show Chart T New IE Delate e O Refresh I @ Detail Map 3‘9 Heat Map I [Z Email a Link ™ o Flow Run Report

& My Act|Ve Accou n'ts e Search for records P

v | Account Name T Main Phone Tl Address 1: City T) Primary Contact Tl Email (Primary Contact) T,
0969 QOcean View Road (415) 555-9933 Jersey - ---
10003 Account 4578755 - Adrian Dumitrascu Adrian@adventure-works.com
A Damc == Alberta == ==
A Datum --- - --- -

Selecting a few records and clicking on the ‘Detail Map’ button on a particular Entity Grid view will open
the following window;

(o) P mapLyTICS" Page 15 of 145
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7 A S L

£ POl ¢? DIRECTION

SSNS-Erait

A
Henry Kaufmann
Campgrounds

Pa i jpoy

It will automatically plot the selected records from the view on the map. Records that do not have their
latitude/ longitude will be ignored and will not be plotted on the Map.

Plot

There are five different search options to plot the data on Map:
e By Location

By Region

By Drawing

By Territory

By Template

Note: The user can also configure the ‘Search Options’ to be visible on the map. Refer ‘Setup
Entity Map’ section of Installation Manual for further instruction.

@@lﬁ'ﬁ'ﬁ?"&k 6’ MAPLYTICS™ Page 16 of 145
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This helps the user to plot the

Maplytics™ — User Manual

@  Plot Records

Cluster map

data using the geocoding of each record.

Search Option

By Location search option also allows the user to perform By Location .

Proximity/Radius Search based on Distance or Time. Gurrent Locaten _
75 at RADFORD STREET Staten Island NY - i)

. . . . Proximity

The Current Location is fetched from the user’s personalization record. A e

The user can also set a new current location using the contextual menu. Show Travel Distance

Refer to the section of the Contextual menu. Miles .
Select Datasource
Account ¥ || Select View T
+

@  Plot Records Select Category

Account Select Categc ¥

Cluster map

Search Option

By Location v
Current Location

1073 Richmond Hill Rd, New York, NY 103 (-)
Proximity Y

® Distance Time

Show Travel Distance
Miles A

Select Datasource

Account ¥ || Select View ¥

Select Overlay

Select Overlay v
+
=] »

Select Datasource dropdown will list out all the Entities (OOB and
Custom) configured for Maplytics and the active views (System views,
Personal views, Maplytics Dashboards and Marketing Lists) that are
available for the selected Entity type. The user can choose one of the

+ Select View
System Views
Select Category Active Accounts
All Accounts
Account sele My Active Accounts
Select Overlay Vendors
Personal Views
Select Overlay Accounts - Staten Island
Service providers - France
+ Dashboards
=] My MNew Accounts This Month|
Sales By Postal Code
Marketing Lists

Campaign - Customer's list

views to plot all the records available in that view.

Note: The user can also configure the ‘Views List’. Refer ‘Setup
Entity Map’ section of Installation Manual for further instruction.

i

w innavative logi
(o) ST
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The user can select additional entities using the ‘+’ button. The user is
allowed to specify a maximum of 3 Datasources for plotting the data
at a time. This allows for viewing Dynamics CRM data across Entities
in a single view on the map.

After selecting multiple entities, the user can click on the ‘Search’
button to plot the records for the selected entities. This helps the user
to visualize three entities on a single map.

Note: User can define the colors as well as pushpin shapes of
the Entity — view combination. Refer to ‘Setup Entity Map’
section of Installation Manual for further instructions.

@  Plot Records

Cluster map
Search Option
By Location
Current Location
75 at RADFORD STREET Staten Island NY 103 \‘/
Proximity Y
® Distance © Time
Show Travel Distance
Miles

Select Datasource

v

~/

Account ¥ || Active Accounts

= /“'n

v v

Leads - NY

-

Lead

< . 1

X X X

Opportun ¥ || All Opportunities ¥

= i 1]
-

Select Category

\ccount Select Categor ¥
Opportunity | | Select Categor ¥
Lead Select Categor ¥

Select Overlay

Select Overlay

+

QPLOT | QPO | o9 DIRECTON 3 a et
S ater
Darth AmhAu lunctind S 2, = B,
o -
R Layer Menu A @ ",
— RA @ :
| @ Plot Records X
\ e\ 4 ®
Z = Cemeter, ¥ ,
" [ Cluster map = E.A emee. (@) E\.A Mo, qv‘“
| Search Option oy a NS : @
T GRANT CI
AErEt Wisona or a =)
By Location Y ¥ Meadows - =
oo E LA TOURETTE PARK = = =
Current Location / Fresh 2 wichmond 84 b 4 ‘.‘
£ ki /
. S @ i Richmond o Y
75 at RADFORD STREET Staten island N'| @ i Creek Ve
v O s ek e v &
- i ebrew O
Proximity FRESH KILLS Lo Tourette Cemetery X
2, Ocean
® Distance 2 Time =) e 5 =
Pt I 4 A 2 .4 0AKWOOD
J Show Travel Distance =/ ’52 ¥
: ﬁ‘\? Q) Q)
Miles v s /| i M WA 0AKWOOD BEACH]
Select Datasource * :_I‘ Q Q ﬁ Q G e
Account 7 || Accounts - state ¥ | X @m) 4 = a ¥
= q‘\ k.ﬁ Great Kills
% lead  v||Leads-NY X e a z Q"A % Harbor
N Opportu ¥ || Open Opportuni ¥| X @ b = @
V £ ®
Select Category s Nﬁ =
Account Select Categ ¥ Q ﬁ
g y= =
Lead Select Categ ¥ D [
= 9 = @ e =
X Opportuni | | Select Categ ¥ Q M;ao/,ffj
ﬂ Park
B s— : =
] e - S
g i " 2 - i
b 8i s i = = z [} View Data 2010 HERE. € 2018 Microsoft Corporation erms.

innavative logic
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By Region
This helps the user to plot the data by the region of records, i.e., City,
State, County, Country, PostalCode, PostalCode Sector, Postal
Code(Outward Code), Postal Code Areas. The user can plot multiple
regions under a particular region type.
e Postal Code: The smallest postcode category, such as a zip
code.
e Postal Code Sector: The second ‘1’ is called “Postcode Sector”.
Example: CA11
e Postal Code(Outward Code): This is called Outward Code, the
part of the postcode before the single space in the middle.
Example: CAl
e Postal Code Areas: The next largest postcode category after
Postcodel that is created by aggregating Postcodel areas.

Note:

@  Plot Records

Cluster map

Search Option

By Region

Select Region Type

Select Region

Select Region
City

State

County
Country
Postal Code

Pastal Code Area

Postal Code Sector
Postal Code(Qutward Code)

2.

SERCT UVErTS
Select Overlay

o The regions that were plotted using the option of Post code Areas before will now be plotted

by using the option of Post code sector.
o The regions will be plotted as per the Bing maps.

Roselle

J /
Layer Menu | L ==

S 1 Linden
@  Plot Records i )
Municipal
2

Cluster map

Search Option 3
fway
- By Region v
2 Regi
Select Region Type
County
Staten Island |
Please Enter State
USA
5

Select Datasource I Sewaren’
N Account ¥ || Accounts - Statel ¥ | famy

F

Select Category

Account Select

Select Overlay Raritan Bay

i
I

Select Overlay N "rth Amboy
i

ViewData |

(o) MRS &P MapLYTICS"

US Coast
Gua:

Station
Sandy,

dmies. | km

82018 HERE € 2016 Microsoft Corporation Terms.
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By Drawing

This helps the user to plot data by defining their own shapes. The user can use the ‘Drawing tool bar’ to
draw the following shapes:

e Freehand drawing
e n-sided polygon
e (Circle

e Rectangle

The user can further edit the drawn shapes by using the following options in the Drawing tool bar:
Edit
Erase

Fill color
Stroke color

@  Plot Records

[ Cluster map
Search Option

‘ By Drawing

Define shapes

, @« re
L Select Datasource S
Account ¥ ‘ éAccounts - Staten v | =
+
Select Category

Account ‘ | Select Categc ¥ ‘
Select Overlay

Select Overlay

l Note: While creating an n-sided polygon, use the ‘Esc’ key from keyboard to close the shape. |

@lﬁ%&k @MAPLYTIGS" Page 20 of 145
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By Territory

This helps the user to plot the data defined in a particular sales
territory. The user can select multiple territories to plot on the
map in ‘Select Territory’ option.

[ Cluster map
Search Option

| By Territory v

Select Territory

10301 - Staten Island

10302 - Staten Island

Select Datasource

|Accaunt v ||Accoun13 - Staten Isl ¥ @

-+
Select Category

|A.ccount ||Seled Category ¥ |

Select Overlay

| Select Overlay v
-+

Save Templaie

() Cluster map
Search Option

} By Territory

Select Territory

0309 - Staten Island

110310 - Staten Island

) ® Select Datasource

7 lAccoum v || Accounts - Staten '] ‘
+
Select Category

Account | [Select Categc ¥ |

Select Overlay

| select Overlay v

+

o — Suspurmcs
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By Template

This helps the user to plot the predefined search criteria in Detail Map. The user can save the search
criteria as a template and use the ‘By Template’ search option to quickly plot the data with that search
criteria. This helps the user to save a considerable amount of time.

For example, if any user is assigned with a task
where the requirement is to regularly plot ‘My
Active Accounts’ records in 2 miles of a

@ Plot Records

[

-/ Cluster map particular location and filter a particular

Search Option Industry, then the By Template option can be
beneficial.

By Template v

Select Maplytics Template Select Overlay

Concentric Proximity Search by Industry ¥
J : : Select Overlay v

| s [
B ==

Save The Template B8

Add to existing template

The User can also define the access level of the

Template as described below:
* Create new template

e Personal —The users can limit the usage of iGolf Course - 2 Miles|
this template to themselves
e Public — Anyone in the organization can Access Level

use this template Personal v

Apart from saving information of Plot Records,
Category card, and filters from Grid, it also saves =
the Zoom level & Center of the map.

Note: Please assign ‘Maplytics User’ security role to Team Maplytics before exploring this
functionality.
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Cluster map

The user can select this option to group the closely positioned pushpins into a cluster. A cluster shows the
number of pushpins in the cluster. The user can zoom in further to break down the cluster into smaller
clusters or zoom out to group closely positioned clusters into one.

Cluster Area

The user can hover on any cluster to see the ‘Cluster area’ which shows the data spread. The data spread
is based on the area covered by the pushpins existing in the cluster.

= ¥ 136 at CENTRAL AVENUE Stat...

Account: Active Accounts: 18

Account Name Y | Main Phone v ‘ Address 1: City Y | Primary Contact b 4 [ Email 4 [
[} Botte & Sons 2122164009 Staten Island -
=} Cammarato & Sons 9175504063 Staten Island |
2 Deforest & Sons. 9172573279 Staten Island
=] @ | Detore &Sons 3126449065 Staten Island
= oemy: -
W @ > [se0 | itemsperpage 1-18 of 18 items
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Spider cluster

The user can click on any cluster to view the pushpins existing in the same in the form of a ‘Spider cluster’.

S
‘ﬁreenmue
& H { ‘}3?
td

%

Layer Menu

ol Plot Records

5 ¥ 136 at CENTRAL AVENUE Stat...

Account: Active Accounts: 18

7 Avenel 7 Y ] s | N 7 de Da i o E,m),,, AEEL

2 Related Reco...

Active Accounts (18)

@ Account Name v | wain phone v | Address 1:city v | primary contact v | emai v
=] @ | Botte &Sons 2122164009 Staten Island I [
=) @  Cammarato & Sons 9175594063 Staten Island
1<} I Deforest & Sons 9172573279 Staten Island
=) @  Detore &Sons 3126449065 Staten Island
I il SRR e
Wie o » o [so0 v | itemsperpage 1- 18 of 18 items

Note: Spider clusters can be visualized only for records less than or equal to 50.

Proximity Search

There are two different options to perform a Proximity Search.
Distance-based Proximity

This option will calculate the straight line distance between the current location and all the points which
fall in the proximity parameter as shown below:
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! E WESTREW =2

g : SRIGHTON,

T ARUNGTON =
) 4 cron; 8

= &
<
k2 = STAPL
WEST BRIGHTON A
N A / %

74 4 S Hession & Sons @
TR — P / P L  Line-of-Sight Distance: 1.24 Miles ; |

Plot Records k y f 2ol mmmnee‘ﬁu Miles - Rost tiamitton

J b é:dmsstsm at BUCHANAN AVENUE Staten Isla
f =

oA

E\f] Road

.

NY 10314 >3

([ Cluster map

| Search Option SHURE ACRES.

| | By Location

Current Location

" | 700 Rockland Ave, New York, NY 10314 @
Proximity
® Distance O Time

@ Show Travel Distance

3 | ‘ Miles
I Select Datasource
i | account ¥ || Accounts - Stater ¥ |
S
~ Select Category
Account ‘ ‘ Select Categ ¥ |
u‘. Select Overlay

| | select Overlay

Enter the radius for the Proximity search. The user can also add decimal values with a scale of 2 for the
radii. The Proximity can be provided either in Miles or Kilometers. The User can also hover over a pushpin
and see the distance from current location.

Concentric Proximity Search

This new addition to Proximity based on Distance allows users to perform up to 3 proximity search
simultaneously. The user needs to enter the distance values separated by a comma (,) and all the points
that fall in the defined proximity parameter will be plotted.
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& Poi

£l Layer Menu

Plot Records
/I
Sherigar & Sons

| DRECTION = SETASCU.. =» SETASP.

b, 435at STEWART AVENUE Staten Island NY
4 10314

Y Line-of-Sight Distance: 1.13 Miles
Shortest Travel Distance: 1.39 Miles

Account Name: Sherigar & Sons

Take An Action

The Concentric proximity zones are represented by different colors for easy visual analysis. The user can
also click on individual proximity zones to highlight the circle and open the Summary Cards for that
proximity parameter.

The user can also filter the data points based on the proximity zone and their proximity distance from the
current location in the ‘View Data’ grid.

Accounts - Staten Island {130) ZJReset | & Related Records | - Mass Actions
‘ ‘ Account Name T ‘ Primary Contact T ‘ Main Phone Y | Shortest Travel Distance T | Line-of-Sight Distance Y | Proximity Zone T
% Abbas & Sons. 7188520069 25 184 2]-
[} Abdelmessih & Sons Abraham McCormick 2122501122 204 132 2 .
E Adamita & Sons Adrienne McMillan 2124180645 043 039 1
% Adams & Sons Benno Kurmann 2122068501 155 11 2
=) Aguayza & Sons 2123082665 321 296 3.56
% Aiello & sons 2128165282 3.88 2.85 3.56

Note: User can enter integer value from 0.1 to 2000 for distance proximity search.

Time-based Proximity

This option will calculate how many points fall in ‘x” minutes or hours of driving distance from current
location. The Proximity can be provided either in Minutes or Hours. The User can also hover over a
pushpin and see the distance from current location.
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Piles :‘
Creek i
¥ Weisberg & Sons =
[s Cluster map 3 & * Travel Time: 6 Minutes §
E i 3
Search Option 5 f ‘ Shortest Travel Distance: 1.45 Miles
P emley. Pomtu * K 4 7 Y 3 Address 1: 75 at RADFORD STREET Staten Island,

By Location v N " NY 10314

Current Location § . . depoty: Newyork podkcode £
g & S Annual Revenue: $344,430.00 2
700 Rockland Ave, New York, Ny 10314 | @ freavis %"’% >
V ¥ / A oy,
Proximity n { b 4
Distance ® Time |

® With Traffic Without Traffic |

15 Minutes ¥ )

Select Datasource 5 ,0 c

Account ¥ || Accounts - State1 ¥ | 55

& b 4

+ % »

Select Category & e ,'

Ac Select Categ ¥ 3 2

Selct % o .

y A % * OAKWOOD BEACH|
Select Overlay v 4
y ,' . g 3 2 Greor ks Park
+ 2
=] p ,' Great Kills
i , Harbor
: @ .i‘? CHARLESTON S"mm\\?ad A I L
b Bmg & | = > B View Data 2018 HERE, € 2018 Wicrosoft Corparation ferms

Current Location
This is used in combination with Proximity to specify the center point for the Proximity search. By default,

this field displays the address stored in the Maplytics personalized record of the logged in user. This is
always represented by a green color pushpin on the map and also indicated right next to the current

location message box.

Show Travel Distance
While performing Proximity Search by Distance or Time, if the user wants to see the actual travelling

distance from the current location till each of the individual pushpins, they can select the checkbox of
‘Show Travel Distance’ to view the Shortest Travel Distance on the hover and view data grid.

= pose

Accounts - Staten Island (103)

7| Y | Primary Contact A v | Line-of-Sight Distance Y | Proximity Zone T
B g 25 184 E
B @ | Abdelmessih & Sons 204 32 3
B @ Adamits & Sons 043 039 3
=‘l_a'| W | Adams & Sons Benno Kurmann 55 3]
— v
Category

This lists out all attributes of the selected entities. Users can choose the attributes by which they would
like to color-code the pushpins plotted on the map. The screenshot below shows the categorization of all
the records of Account, Lead and Opportunity on the basis of the attributes Annual revenue, Rating and

Est. Revenue respectively.
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Note:
e User can choose respective categories for at a maximum of three different entities. Only one
category can be chosen for an entity selected twice or thrice.

The user can define the color as well as shape of pushpins for each parameters of category. Refer
to Pre-Define Colors for Category section for further details.

e Usercan also choose the field attributes to be visible in Category list. Refer to ‘Setup Entity Map’
section of Installation Manual for further instruction.

Bayonne i
r ‘ 5 s ’ Roselle Park Elizabeth Upper New York Bay
i SR e Roselle
o~ Westhela (2 —_— Port Jghrson
Scasa € 1 ety

SQUARE Newark B: izt @ T, &
i © PlotRecords / 3 N Wi( ¥ s’

RS

‘a

Cluster map s 3
i inden

PARKVILLE

GULFPORT

Search Option

By Location v

Current Location

VK ",‘\

1073 Richmond Hill Rd, New York, NY 1 2 Rahway

P Rahway a 4
Proximity il ol
] V@) celTSEN
® Distance Time "\

Show Travel Distance

Avenel Carteretd Great
Miles ¥ €

Lower New York Bay
Port Reading

Select Datasource (55
Account v || Accounts-st ¥ | X 4

& sewarten Breezy
Point
Park

&S | Opportunity ¥ | OpenOpport ¥| X
Lead v leads-Stater V| X
Select Category
Account || Annual Reve ¥

®

Lead Rating v 7 ()

e / Raritan Bay
Opportuni || Est. Revenue ¥ Perth Amboy (@@) /g

Y Y@, @
Select Overlay ;
Raran
Select Overlay ¥
South Amboy,

. B imies  1im
b Bing 2 B View Data US Casst

o ©2018 HERE. © 2010 Microsoft Corporation Terms

Data Grid

©

All plotted pushpins represent a unique record in Dynamics CRM and data grid helps the users to access
these records from the map screen, filter the data further and perform some mass actions.
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Filter Data:

The user can use the filter present on the top of every column to filter the data further. Order of columns
in the grid depends upon the Dynamics CRM View selected to plot the data and in the case of Marketing
Lists & Maplytics Dashboard records, it is same as that of the Entity-View selected in Entity Map. The users
can also customize the data columns to be visible in the grid by adding/removing columns from the Entity
view.

m / poste
v Keivedon Hatig| ! Road

Loughton /
Stapleford

A\
Abbots v,\iulgnms Hatch [X8 5’”@ Hutton

Buckhurst Hill Chigwell s} Brentwood
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° Romford w‘“&w ] ;h‘;\ner:,@
)

Upminster )
/

&yt

Aot u
! <\ Borehamwood @ <Q‘
ord & Barnet
T = ® V
~— \

7
Layer Menu
Plot Records
ORIt squne :

e

Bulp
® |
: /
Rainham
Show items with value that
@ 1 equalto South Ockendon
] tono m
foucdn Belvedere =
omes s
And v Purfieet . West Thurrack Grays
Tisry

e
[ Gieennitne

») oo Northflee
= Rested e

Email A4

1- 50 of 1136 items

Reset:
This will reset the grid to the initial search.
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Parent Record / Related Record:
This is useful when the user is dealing with plot related records functionality. The user can switch between
child data and parent data using this button.

Resizable Data grid:

Double click on El Expand button to view the data grid in full screen. Double click on Collapse
button to view the default size of the data grid. Use can also click once and drag to resize the data grid to
the desired size.

Linden | 2
Rahway. @
bt Long
1 @ Select All @
/
@ Blank * @
@ Banking =
Accounts - New York (350) | CReset| = Retated Records
@ | Account Name Y | MainPhone Yy | Address 1.y | Email Y | Expected.. Yy | Industry Y |Owner Yy | Sales Y | Territory 'y | Website Y
R. PETER KANAKOS & SONS 8464352048 10306 pamela10616@inogic.com 14976089  Engineering Joe Smith 400000 10306 www.inogic14148.com -
L PAUL CASTRUCCI & SONS 36577023498 10310 beth10516@inogic.com 14843411 | Transportation sams 800000 10310 http://www.inogic14040.com
R. WERNER MORATH 8 SONS 5208663787 10308 robert10942@inogic.com 14779901 | Engineering Joe Smith 700000 | 10308 www.inogic14488.com
Y. ANTHONY TAKOS & SONS 33982746370 10306 john11009@inogic.com 14719345 | Social Service William Smith 400000 10306 Www.inogic14558.com
K. FRANK CAMINITI & SONS 41133044516 10314 james10792@inogic.com 14698054 | Transportation sams 290000 | 10314 www.inogic14333.com
Z. DARIUSZ MAKARA & SONS 14959555031 10314 judith10814@inogic.com 14685001 | Transportation sams 290000 10314 www.inogic14355.com
J.N JKATZ 8 ASSOC. INC. & SO... | 14141242839 10314 silkaly10483@inogic.com 14496539 | Engineering sams 290000 | 10314 Www.inogic14007.com
S. JAMES FEUERBORN, JR. & SO... = 7124852777 10307 lawris10932@inogic.com 14418039 | Social Service William Smith 1000000 10307 www.inogic14478.com
S. STILES SHAWN 8t SONS 39591012028 10314 mark10408@inogic.com 14394467 | Engineering sams 290000 | 10314 www.inogic13931.com
S. JESUS COOMBS & SONS 33719694353 10306 larry10333@inogic.com 14372710 | Engineering Joe Smith 400000 10306 www.inogic13855.com
H. ELIZABETH DI SALVO & SONS | 39192804098 10304 chris10629@inogic.com 14337160 | Banking sams 200000 | 10304 www.inogic14161.com
R. OMAR ELSHERIF & SONS 18792802791 10306 melanie1972@inogic.com 14332454 Engineering Joe Smith 400000 10306 www.inogic5217.com
R. NASIR KHANZADA & SONS 2422058921 10309 stanley10653@inogic.com 14173893 | Engineering sams 200000 | 10309 www.inogic14186.com
S. JANIS VACCA & SONS 23584616947 10306 christopher10957@inogic.c... 14111729 | Transportation Joe Smith 400000 10306 Www.inogic14503.com
T — e . e oo | SN (S S =
PR @ 2 (»)(M) 200 v | itemsperpage 1-200 of 350 items
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Highlight pushpins:
User can click on any record within the Data Grid to highlight the respective pushpin on the map. User can
also click on any pushpin on the map to highlight the respective record in the Data grid.
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Mass Action Buttons

The user has the option to take actions on the plotted records like adding to route or executing the
workflow on selected records in the grid. Defined mass actions are as follows:

e Add To Route: This option will add selected data points to the route. The user can add at max 25
data points to the route

e Save Data: The selected records can be saved as static Marketing List or Personal View in
Dynamics CRM

e Change Owner: The user can assign the owner of the plotted records by selecting a user or a Team

e Manage Territory: The User can assign or change the territory of selected records

e Send Email: The user can send a mass email to the selected records. This will open the list of
available email templates or new blank email

e Execute Workflow: The user can execute any on-demand workflow with this functionality

e Export To Excel: The user can use this feature to export data from the map to excel. This
functionality adhere to CRM security roles, if the user does not have the permission to ‘Export
Data to Excel’ in CRM then that user will not be able to export data from Maplytics

o Create Activities: User can create activities for non-activity Entity records currently selected in
“View Data grid.” The user can define the Activity, Subject, Duration, Owner(User/Team) and
Priority. The user can also select the number of activities they want to create from Mass actions.
The activity selected in respective Entity maps can be seen in the Mass actions list under the label
of “Create activities”, by clicking this label below window will open which will list the activity
selected in respective entity map.

e Auto Scheduling: User can use this option to schedule a plan for the plotted records. Refer to the
section of Auto scheduling.
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Tooltip Card

User can click on any pushpin to open a tooltip card. This — =
card will display the data like Address, Account name etc.
which is defined in the Tooltip Mapping section of the = DIRECTION =+ SETASCU.. = SETASP..
Entity Map.

¥ R WALTER PRATHER

280 MEREDITH AVENUE STATEN ISLAND NY
USA

Full Name: R. WALTER PRATHER
Email: some_26443@inogic.com
Business Phone: 5183734439

Take An Action

CO0HOOE®

¥ R WALTER PRATHER

= DIRECTION =¢ SETASCU.. =p SETASP..

280N * SetAs Origin IN ISLAND NY User can also set a particular record as ‘Origin’,
USA| ¥ SelasDestination ‘Destination’, ‘Add to Route’ under Direction, ‘Set as

= Add To Route L Current Location’ and ‘POl location’ from the Tooltip
Full Namer R WALTER PRATHER card

Email: some_26443@inogic.com

Business Phone: 5183734439

Take An Action

COOHOOE
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Hover:
User can hover on Dynamics CRM Records plotted on the map to have a quick glance at its details.
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= > o L Ay
107 ond Hill Rd, New York NY 10306 | i -4 ). 2 »
* »* : ; ,:‘
Time Carteret b 4 GRANT
Show Travel Distance ; e » b 4 S
¥ | Goldstein & Sons
Select Datasource T Address 1: 104 at MCARTHUR AVENUE Staten Island, N
2 o e o s Y 10312 ’&
ot . Seaten X A Territory: New york postalcode P2
+ S A Annual Revenue: $151.096.00 )
ot ) 048 ; e .
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| = : 3 T ez X
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8 » 3 Bl B o R
‘, Barber 5 4 e ,'
[/Hcpe:awn i 3 > @ L— J‘ * * *
ok I8 N 4 Far S\
bBing * pes EView Data cavtsrere S 20fs

The user can have a maximum 6 different attributes here apart from the title attribute. Refer to the ‘Setup
Entity Map’ section of Installation Manual for further instruction.

Quick Call to Action Buttons:

User can associate quick action buttons. This helps in saving time while switching between screens to take
actions. First four actions are the default actions and cannot be changed by the user, but they can modify
the rest of the actions. The default records are as follows:

e Change Owner £2: Assign an owner to the respective record by selecting a user or a team

e Open Record © : Open record directly from this screen to edit any field

e Plot Related Record 2 : Plot One-to-Many Relationships/Related records of a particular record
as shown below:
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Plot Related Records

Select the relationship to plot related record

[ account - customeraddress
(Account_CustomerAddress)
(3 account - contact
(contact_customer_accounts)

Select the required relationships from the list and click on ‘Plot Records’ button. Related records will be
plotted as shown below. Use ‘Parent Records’ button to switch between Parent and Related records data

&
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v Full Name Y  Email Y | Company Name Y  Susiness Phone Y
a v Antonette ORTEGA Antonette.ORTEGA@helper.com LORDS INSPIRATIONS LTD A
=] v Jerrie MITCHE Jerrie MITCHELL@contoso.com LORDS INSPIRATIONS LTD
i} v Louvenia CHE! Louvenia.CHEN®helper.com LORDS INSPIRATIONS LTD
B v Lucretia LEWIS Lucretia LEWIS@contoso.com LORDS INSPIRATIONS LTD
1-40of 4items

W @ > (o | itemsperpage
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e Run workflow @ : The user can execute on-demand
workflows on an individual record. When clicked on Execute Workflow %
this button, it will open a window which will list down
all the on-demand workflows available for respective Select Workflow
Entity as shown below : nogic.Maplytics AssignTerritoryWorkflow ¥

Inogic.Maplytics.AssignTerntoryWorkflow

Inogic.Maplytics.GeoCoding

The user can customize the rest of the actions according to their requirement. In this example, we have
added the following three actions:

e Email ©: Send email to this record

e Add Task &) : Add task to this particular record

e Appointment (=) : Schedule appointment with this record

The user can define these actions under ‘Advance Settings’ in Entity Maps. Go to Setting > Entity Map >
Select Required Record > Advance Settings > Tooltip Card Actions or refer to ‘Setup Entity Map’ section
of Installation Manual for further instructions.

Reset Map

User can use the button of ‘Reset Map’ to reload the map with the initial Detail map
settings.

O D@

Note:

o This action will clear all the data plotted on map

e The refresh map button will show the same data on the map in the following conditions:
o Expanding the map or plotting a route from a dashboard
o Using the map button from an individual Entity record page
o Plotting a route or a template
o Plotting records by selecting the records from the Entity records page
o User had set a default template for the Detail map
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Overlay

©

This helps user to view the Dynamics CRM records along with shapes files
and existing territories plotted on the map. User can also view the ‘layer
menu’ to select or deselect the layers so as to show or hide the same

respecti
analyze

vely. Using Overlay user will easily be able to understand and
the data spread in required shape file regions and territories.

User can select the following two options:

Territory — This option helps the user to select among the list of
existing territories

Shape file — This option helps the user to select among the list of
shape files

Shape file in territory

Cluster map

Search Option
By Location

Current Location

Proximity
® Distance

Show Travel

Account ¥
+
Select Category
Account

Select Overlay

Accounts - Statel ¥

Time
Distance
Miles

Select Datasource

=

Select Overlay

Terntary
Shape file

A shape file should be saved in a territory in order to be visible in the list of the shape files. Follow the
steps mentioned below:
Go to Settings > Business Management > Sales Territories > Create a sales territory > Save
Go to Territory Map Preview > Select By Shape File > Choose a shape file > Save

TERRITORY

e New York

General

Define Geography ~ Configuration  Territory Map Preview  Related

4 VERMONT!
Mississauga® r \
— )
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|
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Convert overlay to territory

. O] | New [ Delete () Refresh [ Email a link o
User can use this button to convert an overlay record

to a territory. After the overlay record is converted, it @ E;T%RY o stat
becomes a territory which can be searched in the ensus by tate
option of ‘Territory” in Overlay.

General Define Geography  Cenfigurations  Territory Map Preview  Related

Territory Name " USA Census by State

Note:

e Supported file types for shape files are .shp, .kml and .geojson
e In a territory, either a shape file can be saved or geographies can be created
e Only one shape file can be saved in one Territory

Summary Card

The user can click on any enclosed area to get the summarized information of the plotted records in that
area in a summary card. The area clicked will get highlighted and the respective data will be visible in the
data grid. The user can customize the settings for this under the Summary card section in the respective
‘Entity Maps’. Refer to ‘Setup Entity Map’ section of Installation Manual for further details.
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With territories plotted on the map, Summary card also shows the link to open the respective territory
from the card itself.

@'hlaov&ve'% ﬁ@ MAPLYTICS™ Page 37 of 145




Maplytics™ — User Manual

¥ 10314 - Staten Island

0314 - Staten Island

Total Records: 26

Territory:

Account - (All Accounts): 26
Annual Revenue (Average): $38,711 538 46
MNo. of Employees (Sum): 161 300.00

Layer Menu

This helps the user to select the required data among the multiple data plotted on the map. The user can
use the toggle buttons on the Layer menu card to show or hide the required layers of the data to be shown
on the map without removing the same from map.

Route

Hotels(Loop Rd, New York, NY
10314)

Restaurants(475 London Rd,
New York, NY 10306)

ol Plot Records

POI

Directions

Hotels

Restaurants
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Note: Layer menu card is collapsible but a user can not close this card exclusively.

The layer menu card will show the following icons

for the respective layers mentioned:

Layer type Icon Layer type Icon
Data source ® Territory 1
Route POI
Proximity Cluster Pushpin
Drawing Shape Shape Operation

Region Shape

Overlay- Shape file

Plot-child

Territory Management —
Shape file

Note:

pushpins visible on map

the Data source layer

innavative logic

imnoGic

6@ MAPLYTICS™

Layer icon for Data source layer, POI layer and Plot-child layer will change depending upon

If category is selected in the plot card, the layer menu card will show only the default pushpin for
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Show/Hide Labels

User can click on the ‘Show label’ @ button to view the labels for the pushpins, regions as well as
territories plotted on the map. User can again click on ‘Hide Label’ @ to hide the labels showing on the

map. The option for showing/hiding labels is available for every individual layer of data plotted on the
map.

" ‘ @ PLOT £ POI of DIRECTION i |4 Francene

P E Grove®*
| El
Barowsy G
g
€& layer Menu Marton sl b7

LeoroyS

B @ RegionLayer J‘ Harkson st

[Housans;

B © Alleads ® Homson U0

Plot Records

Broadway-Lafayette st [ ¢

o Prince st (1]

¥
o
\ £ BroadWay..

‘Suzi

15 oW

Note: Show Labels is available for less than 5k records.

Show/Hide Territory List

With territories plotted on the map, layer menu Ll ea
will also show an option of Show/Hide List for the
layer of territories. User can click on this option to

P & Teritory Layer|Show Lis
open the list of territories plotted on the map. User st v -4y U m
can further select or deselect the territories which

are required to be plotted on map.

___' @ Al Accounts @

@un‘a""' -

60 MAPLYTICS™ Page 40 of 145




Maplytics™ — User Manual

* Territory List

[ Select All

W 10304 - Staten Island -
] 1030% - Staten Island
] 10306 - Staten lsland
l# 10307 - Staten lsland
# 10308 - Staten Island
|« 10309 - Staten Island
# 10310 - Staten Island

[« 10312 - Staten Island

Contextual Menu

User canright click on the map to open Contextual menu. It provides commonly
used features in Dynamics CRM like creating a new record, set
origin/destination or selecting map zoom level on the map. The contextual Directions >
menu provides the following options: Add To Route

Create New Record

Set As Current
Location

Set As POI Location

Create New Record: Save Settings >

User can right-click anywhere on the map or POI result =
icons and create a record for that particular location. This
will save the record with the details of the address and
the geo-coordinates (Latitude & Longitude).

What would you like to create?

L. . Contact
for existing record pushpin Lead

Note: Create new record option will not available ‘ Account
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Directions:
e Set As Origin: This option will set the address of the pushpin/map location as the start location of the
route.

e Set As Destination: This option will set the address of the pushpin/map location as the end location
of the route.

Add to Route: This option will set the address of the pushpin/map location as a middle waypoint(s) of the
selected route. For example, the user has selected Point A & B as orgin & destination respectively for a
route and now clicks on the ‘Add To Route’ option, the Point B will remain as the destination and will
become the Point C. The address of the selected pushpin will become the Point B of the route.

Set as Current location: User can click on any pushpin or anywhere on the map to set the address of the
pushpin or the location as the current location respectively, which can be used for Proximity search.

Set As POl Location:

This option helps the user to set the location for the Point of Interest (POI) searches like ATMs, restaurants,
Airports, etc. Setting the POI location, user can search for various Geo-tagged & Bing mapped locations
around it.

Save Settings:
User can save the default settings for the following options. These settings will be saved in the

Configuration details record of the user:

e Current location: This will save the location as the default current location.

e Map zoom level: This sets the zoom level and map center for the Map. After this setting is done,

whenever the user will open the Detail Map, it will be zoomed down to the location set here.

e Origin: This sets the location as the default origin.

e Destination: This sets the location as the default destination.
User can also click on any pushpin to get a contextual menu. Along with the options mentioned above,
this will provide the following options:

Open record: User can open the record form right from the map and can Open Record
further edit the details for the record. .
Directions 14
Actions: User can perform the following actions on the pushpin selected: Add To Route
e Add Task: This option helps the user to create a new task in Dynamics Set As Current
CRM regarding the selected record. Location
e Schedule Appointment: The user can use this option to create a new Set As POI Location
appointment for the selected record. _
e Manage Territory: The user can assign/re-assign a territory to the Actions >
selected record from the map and hence can manage the territory. Save Settings b
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Census data Visualization

This feature helps the user to visualize census data on the map. Census data provides the information
about the population for a whole country or parts of country. Visualization of this data on Maplytics will
help the user to analyze various information of the required area in a country like Housing units, Area
land, Area water, population demographics, etc. and take strategic decisions. A few census data are
available by default within Maplytics. These default census data are provided by Bing maps for USA. User
can also plot their own shape files on the map which contains census data.

To plot the census data, user can choose the option of shape files in the feature of Overlay. Please refer
to the section of ‘Overlay’.

Beaufort Sea

Layer Menu
@  Plot Records o

Cluster map
Search Option ey
8y Location CANADA i
Current Location
Claibourne, OH

Y proximity

® Distance Time

Miles

Select Datasource \

bacific Morocco,
<

Account ¥ | | Active Accounts ¥ Jcean

+

Select Category *% MEXICO cuea

Sargasso Sea Atlantic

Ocean
ALGERIA

o

Account || Select Categ ¥

Select Overlay

- Sta.. X Select Attribut ¥

Coral.
Sec

b Bing E View Data

500 miles 4000 km

2010 HERE. € 2010 Microsoft Corporation Terms.)

Configuration for Census data

User can configure the Census data provided by Maplytics in the Dynamics CRM. Please refer to the
section of Configure in Installation manual for the steps to ‘configure’.

While configuring the census data into Dynamics CRM, territories will get created within which the
respective census data will be saved in the form of geographies. To view the saved census data, Go to
Settings > Business Management > Sales Territories. Following are the territories for census data created
on configuration:

e (Census data - States in USA

e Census data - Counties in USA

e Census data - 111th Congressional Districts in USA
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Configuration for attributes

User can configure the attributes available in the census data/shape files to show on the map, create
categories for attributes and select the colors to visualize the categorized data on the map. This allows
the user to frame the data how they want to view on the map.

Go to Settings > Business Management > Sales Territories > Territories with census data/shape files
saved > Configuration

e Attribute Configuration:

o Summary Attributes:
User can select the attributes to show on the Summary card shown on the click on the
regions in the census data/shape file plotted on the map.

o Hover Attributes:
User can select at a maximum of 6 attributes that will be shown on the hover on the
regions in the census data/shape file plotted on the map.

o Data grid Attributes:
User can select the attributes from the census data/shape file to be shown as columns in
the data grid in Detail map.

4 Attribute Configuration

Summary Attributes Actions Hover Attributes Actions Data Grid Attributes Actions

:
+
X

+

Name

Population

(=100 ="RN= 000 J

Area_Land

e Category Configuration
User can create categories for the attributes in the census data/shape file. Creating categories will
help the user to view the categorized census data for the required attributes in the desired colors.
Some categories are provided by default for configured census data. User can click on # new New
button to create a new category for any attribute. User can also click on # ‘Edit’ and T ‘Remove’
to make changes or delete the existing categories respectively.

Create Categories + New
Name Actions

Population i)
Area_Land i
Area_Water i
Pop_Overlb Palin)
Pop_Male_Overlf i
Pop_Female_Cverlf i -
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= Create filters and define colors
After clicking on Edit/New button, user can filter the attributes and define colors for the
ranges of the filtered attributes.
o Attribute: This shows the name of the Attribute for which the category has been
created/will be created.
o Display Name: User can type a name for the category which should be displayed in the
list of the categories.
o Save: User can click on save button to save the changes made.
o Discard: User can click on Discard button to discard the changes made.
o Filter: User can set various filter conditions for the category.
o Value: User can set values for respective filters set.
o Color: This can be used to set colors for individual filters set. The user can click on the
>¢ Auto Set button to set random colors for all the values.
o Add/Remove: Click on Add or Remove to add a new filter or delete the filter respectively.
Attribute |Pop_FemaIe_D\.rer16 | Display Name |P3p_FemaIe_Over16 | H 2 X
Attribute Filter Value Color Add Remove

Pop_Female_Over.. | Is Less Than v |30[]C'[:|0O | - + X
Pop_Female_Over... | Is Between v |3ODC'[:'0O
Pop_Female_Over... |Is Greater Than ¥ |5ODC'UUO | Iﬂn’d" + x

| [soooo00 | - + x

After the user has created categories, user can plot the census data along with an attribute selected to
visualise the categorised Census data on the map as shown below:

@,

-~

i QPLOT £ POl of DIRECTION { (¢ Cg:&s;A SASKATCHEWEN. OhTario

Layer Menu

F*  Census data - States in USA - ...

VAT (NGRTHIDAVOTAY Staitre

DO @z S S0 v | items perpage

¥ SelectAl z y 8 @
Census data - States in USA ol o e
Teiis e _ U =
@ <10000000 [ ] D o @
@ >20000000
@ 10000000 - 20000000 [ ]
Plot Records
Sargasso Sea
Gulfof Mesco
Havana
MEXICO . e
Mexico City oo,
: o) s
sl e 0
5 Caribbean Sea o
4 B Hide Data oo S
census data - states in usa (52)

@ | EntityiD

Y | Neme Y | StateCode Y | Population Y | Arealand Y | AreaWater Y | Pop Overl6Y | Pop_Male.. ¥ | PopFema..Y  Pop Over21y | Pop_Male.. ¥ | Pop_Fema..Y | Pop OversSY | Pop_Male.. |

Alabama AL 4779736 1311724031... 4594951242 3781800 1810745 1971055 3431106 1632856 1798250 657792 278506 2
Alaska AK 710231 1477849359.. 2454877009... 544208 284293 259915 491763 256540 235223 54938 26806
Arizona AZ 6392017 2942052822, 1027790845 4944481 2437034 2507447 4478620 2197021 2281599 881831 401695

Arkansas AR 2915918 1347716034... | 2960200961 2284744 1108864 1175880 2077218 1003093 1074125 419981 182992
) >

1- 50 of 52 items

innovative
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Shape Operations

With the help of Shape operations, users can perform Binary operations on the shapes drawn on the map.
These operations can only be performed under the Search option of ‘By Drawing’ in the Plot card and
Territory management section. Please refer to the section of Territory management for the shape
operations in Territory management.

User can open the ‘by drawing’ search option and right click on the shapes and can choose the option of
‘Shape operations’. The following five operations can be performed on the shapes:

o Difference: This highlights the shape(s) obtained by subtracting the overlapped ones from the
selected shape
! e \ Haverhil
Banb: v
@POT  gPoI  DRecTioN i [ By e | Susoury Bx] 1 [m] ’
w
e } ) \
/n Layer Menu Y m‘ ’ Stour iy Felixstowe.
| 5 \ Stéyenage ] A @
o lenehomt \ unsiaie=guton \ Se‘zmgfo Srainties olchester
\ / )}
Cluster map Ay | (> acil. / Witnam Clacton on a8 @
Search Option Oxford Hemel Hempstead  Saint Albang Harlgy
4‘ o == { Chelmsford @
By Drawing v = \J )
Abingdon mi IR
Define shapes High Wycombe f Watfora, Loughton,p urrwood L%
2 @ O@E= R \
. ;!/ il Basildon
Select Datasource Maidenhead Southend-on-Sea
=Sl h
% [Account v |[Select View " ® S gonder [ Grays
Select Category Newbury By @ \«;w n s.::“u )| : ity
£l g [z N fR5crie: . Heme gy Margate
Account Select Category ¥ g woriog ttingbourne - Sugle Whitstable Ramsgate
Select Overlay — N N
elect Overlay B f 2 )\f, M3t tone, Canterbury
Select Overlay b 7 B o
clect Derley 5 4 pgiond Create New Record
/ Shape Operation » | Difference
/ N Directions > Intersection Dove
Salisbury Winchester Horsham Add To Route Union e
Set As Current Union Aggregate
3 “{,,_. South Oowns Natioral Pork Location Disjunctive Union
GtEn Set As POI Location Pl
Eanton : “ h Doy Save Setti >
Sourt Wi,
S =7 R Watergouile o R o, 7BV9”i ings o
New Fo Chichester Littlenampton Bright Z {
Femdown = Portsmouth Worthing O St L&
= 5 New Milton i IR Seazeidens Eastboumne
e =7 SEoumemouttindll ot e B e e i
g e s R
e Intersection: This highlights the shape(s) where the selected shape and other shapes overlap.

innavative logic
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SN\ 7

@ PLOT &Poi 9 DIRECTION
é =

E W Layer Menu

Plot Records

() Cluster map

Search Option o } d
[By Draving v ,,,)J /
Define shapes

Nl
Select Datasource
[account_v][sekectvien v |®

+

Select Category

[Account [ Select Category v

Select Overlay

Select Overlay v

4

e Union: This adds all the shapes overlapped on the selected shape

1

8~ d o 5>
@ PLOT 2rol o9 DIRECTION H 1 O \ > { . ¥ Road
PR N L

E 3 Layer Menu
Plot Records

L Cluster map

Search Option

[By Draving 2
Define shapes

©l=ealeal |
Select Datasource

Account ¥ |[selectView  v|@®

+

Select Category

Select Overlay

Select Overlay v
+ |

e Union Aggregate: This performs union operation on all the shapes that are drawn on the map. If
a shape does not overlap with any other shapes, it highlights such shapes and the union of the
rest of the overlapping shapes.
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i | k“
@ PLOT Lol o9 DIRECTION

o .
E_ B Layer Menu

Plot Records

) Cluster map
Search Option
8y Drawing

Define shapes

OE@OOOE e
Select Datasource
| [account v|[selectview  v|®
+
Select Category
[Account | [Select Category 7|
Select Overlay
| select Overlay
+

¢ Disjunctive union: This highlights the shapes that are not overlapped and lie in the selected shape
& the shapes that are linked with the selected shape

> J “
@ PLOT Srol of DIRECTION  } /

E_ 8 Layer Menu \

@  Plot Records

) Cluster map
Search Option

|By Drawing |

Define shapes
aBltoelale] [
Select Datasource

§ [Account v][selectvien 7| @

+

Select Category

Account | |Select Category |
Select Overlay

Select Overlay v
%

Undo — While performing operations, user can use the option of ‘Undo’ to go only one step back
into the binary operations performed
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Reset — Using the option of reset, user can remove all the operations that are performed on the
shapes drawn on the map

Note:
e To perform any operation, two or more shapes should overlap.
e For Union Aggregate, there should be more than one shapes with or without overlap.
o The highlighted shapes are new shapes as resultants of the operations performed. User
can click on the highlighted shapes to view the summary card and the data in the view
data grid.

Territory Management

Territory management helps the user to create new territories and align the existing territories. User can
plot regions on map with files or by location of regions. Based on the analysis of the plotted regions, user
can use the Alignment tool to select the required regions and create new territories. Further, user can
plot the existing territories and edit them to perform proper Territory distribution.

Go to Detail map > More Options > Territory Management

FINLAND

J‘ = Print

X & Download
|

Note: Users other than System Admin, can use Territory management only if they are given the role
of Maplytics Territory Manager
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User can use the search options to plot shape files, excel
files, search by region, draw a shape or plot existing i
territories on the map. There are four search options:

@PLOT QPO

e ByFile
e By Region @ Territory Management
e By Drawing Search Option
e By Territory By file
By Region
By Drawing
By Territory
By File:

This helps user to plot the shape files and excel files on the map that store geographical information and
attributes of the geographic features. User can plot the following two types of files:
o Shape files: The supported file formats are .shp, .kml and .geojson

CODE: CA06
. | NAME: Northwest Territories

StatPlanetCanada ( Fi Create Territory | SReset | © Export To Excel
@ CODE v | name v
| cao | Alberta z
w CAll Saskatchewan l
CA03 Manitoba
CAOS Newfoundland & Labrador

I W @ > [s00 | itemsperpage 1-130f 13 items

o Excel files — The supported file formats are .xIsx, .csv
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QPLOT QPO o9 DIRECTION

- E—

@ Temitory Management

Search Option

| By File

Choose File | USA States.csv

Supported file type: Xisx, .csv, shp, .kml and .geojson

USAStates (1628)

@ | Name Y | Color Y | RegionfFilter Y | RegionType Y | RegionValue Y | SearchOption Y | Territory 6 4
@ Chris Paraghamian #7CFCO0 UsA State spokane County 1 Chris Paraghamian -
@ Troy Vanbrunt #6495ED usa State Pulaski County 1 Troy Vanbrunt .
@ TonyFebles #DAAS20 UsA State Corozal County 1 Tony Febles
@ Sterling Delbridge #006400 USA State Edmunds County 1 Sterling Delbridge

TR o 2 3 45 .0 50 v | items per page

1- 50 of 1628 items

Note: The excel files should be in a predefined format so as to get supported by Territory
Management. Please refer to the section of Bulk Geographies by uploading an Excel file

By Region

@ Temitory Management

This options helps the users to search for regions on the map Search Option
by City, State, County, Country, PostalCode, PostCode
Sector, PostCode(Outward Code), PostalCode Area.

| By Region ¥

Select Region Type

City v
Select Region

City

State

County

Country

PostzlCode

PostalCode Sector

PastzlCode(Cutward Code)

PostzlCode Area
—_———
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Territory Management

Search Option

| 3y Region b ‘ =

Select Region Type

{ PostalCode bl

% | 10301, 10302, 10303, 10304, 10305, 10306, 10307,

N { Please Enter State

|
|
1 Please Enter City ‘
l
|

[usa

e
Q@ Plot

By Drawing

This helps the user to draw a shape using the custom Drawing Tool Bar.

Q@ Temitory Management

Search Option

By Drawing ¥

Define shapes

(Ymo)o)s)2 0@
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Sl I Y
QPLOT QPO

Search Option

By Drawing

Define shapes

Elolelnlel ]

By Territory

This helps user to plot the existing territories on the map.

S Pol of DIRECTION

Territory Management

Search Option

[ By Territory

Select Territory

. N e
| 75019 France x | 75020 France x | Romainville

> /- Le}Pre:St-Ge Z= A
75116 France x . 5 2
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Territory Alignment Tool

This tool has four options respectively as mentioned below:

o Select/Deselect: User can select
regions/shapes/territories one by one on the map

e Deselect All: User can deselect all the selected
regions/shapes/territories on the map

o Select Multiple: This is a freehand selection which helps the user to select multiple
regions/shapes/territories on the map

e Delete: User can delete the shapes/regions/geographies plotted on the map

Note: If the delete option is used on the existing territories, it will delete the selected
geographies from the existing territories.

Note: Territory Alignment can also be performed on Plot card.
o The option of ‘create new territory’ works on all enclosed shapes except Proximity circles.
e The option of ‘Move to/copy to’ works on all shapes of plotted territories.

Create new territory

User can select some of the regions/shapes and create a new territory.
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Create new territory

) Add to existing territory

® Create new territory

| B46_UY

Select Manager

1

Select Manager

L

B1, B2, B3, B4, BS, B6, B7, B8, B9, B10, B11,B12, B1 1|

S Please Enter City i cRRDLEY

\ Please Enter State

—
WEDNESEELD Rushall Ajgrigge: Wilnecote/ Sheepy Magna
= Little Aston Drayton & 5 " Road
® < Bassett ez e(uley’ L
Ackleton i) Willenhall - Walsall Mere Green |\ Michleton et 4
o1 Layer Menu \ Atherstone J
= 5 - " Bilston' . Baxterley: Fenny Dra,
8 [ n63 Sutton
@  Tenitory Management Wednesbury Coldfield Witk . B4S UK Caldecote
) coseLey i /\\/\6 o Hartshill m@
§ Search Option y 5
- rou
By Region v o
B West Brom! Shustoke Al ; Aftegorough
Select Region Type Dudley i 27 Stockingford
PostalCode A Oldb’urrm °
§)f |PostalCode Areas sford smethwick B FF Grif

i Ubudge Halesowen 4 o Rathes ECL {
RS [ As036] “9ham Roag
id
Hagley. /  ass]
west Hagle; J
Sl W Berkswell s o
BiNey
Balsall
A Knowle Common
X | rayton  a41] Dorridge Westwood Heath

: 4 Fen End 7 A

o 8aginton o

7 C'“drti"w Dfatsmu Earlswood Cinscre
\. / - Chadwick End 6
‘ Great Dotifora* (L = %
RS / a0 Kenilworth o "
5 Bromsgrove Tanworth \ Beausale
‘ e NS P
Cutnall Green Stoke Heath i Cubbington
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m Ullenhall Z
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Create territory on one click

User can create territory(ies) with a single click on ‘Create Territory’ button. User can plot shape files or
excel files on the map to view the shapes required as geographies and follow the steps mentioned below

to create territory(ies):

Oz &rwwurmcs-
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By Shape file:
After plotting a shape file on the map, user can click on the ‘Create Territory’ button to create a new

territory with the plotted shapes as geographies or create the plotted shapes as geographies into a
selected existing territory.

o Mawdesley |1 \
£ \ ' Greenmoun
Q@ PLOT L POl ¢ DIRECTION < Coppull
= e Adllngton i
i Bursmhgh Tottington
dge “ )
Layer Menu icough ‘> i 7
- _ Parbold Blackmd\ Horwich Bury ! Heywood  Castlet
Newburgh Appley Ainsworth 51 -,
@  Temitory Management Bndge L\ m 2573 Bolton 1 = = 1
] AspuH ) I 7 :
| Search Option hrad Daiton Eathurst Mar lebone ngltes { Ac6) Radcliffe \ -
) = Little Lever /
o] o il £ \ 9%
By File Skelmersdale |ga e wésthougmon gy _Fernworthy Phitetelgh
Choose File | Wigan km " LA r— ~_/ >
‘7' 9 aeatte e Rembérton” TiCe-in-MaKerfield \ e g Little K\ _#Prestwich
ted file type: xisx, .csv, shp, .kml and .geojson A ( N —__ Huiton D T
2 — )~
Crawtord \» \ = By | Pendiebury
1 o \‘ B aso0} / Swinton
[\, simonswooo Rainford o | Boomstown {
\ Billinge \ \\ Salford = \
R\ p 4 — )
[ Kitkby nows! = Lowtop \V/ ¥ Droylsdens’
o e TS N o Manchester oo
N / \ / .\k e udensha:
NG { = N o {
NG <=7 / = 3 %, 3 \
. Newton-le- WlllowsH Kf"w V4 \ & %, Dentirw’\
Saint Helens S Urmston 8
> il {stretford : \
\\ Croft _»Mm s o \’?_V\ B oA ReDDISH \\
Prescot Burtonwood Winwick _ .
" G L g}@ Cadishead Sale \‘ );9
ot

/Walla"sey \ R \‘l Phistog / E Hide Data \ Partington N\ /2 oissaumy (A
Wigan (25) Fi Create Territory m © Export To Excel

v name Y OBJECTID Y

v Ashton 1 -
v Aspull New Springs Whelley 2

v Golborne and Lowton West 3

v Lowton East 4

D @ (R} 50 v | items perpage 1-250f 25 items

Create New Territory =

') Add to existing territory
® Create New Territory

Flease enter the name of territory
Select Geography Name

Select Geography Name
Select Manager

Select Manager

User can provide the name for the new/existing Territory to be created and the respective names of
geographies will be fetched from the file.

By excel file:
After plotting an excel file, user can click on the ‘Create Territory’ button to create territories along with

the shapes plotted on the map as Geographies. The names of the territories and the respective
Geographies will be fetched from the excel file.
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Move to

User can select some geography(ies) of one or more territories and move it to another plotted existing
territory or create a new territory. This will remove the geographies from the original territory.

@  Territory Management

Search Option

HUNMINGTON
8y Territory

Select Territory Walton Hill Romsley

B31_UK x | B32_UKx | B38_UK X | B45_UK x
Eastf

B48_UK x -

3
=
s 3 .
= Copt Heath

Knowle

( 3
Cheswick Green

Dorridge

Fairfield

jf‘%iwood
3 J

4

Elmley
Lovett. Pink Gree‘n

Beoley

| z

; é’, 1 miles 1km
= MOONS MOAT NORTH INDUSTRIAL ESTATE S R S T
Data Thaes] y Dean’s Green ©2018 HERESE2018 Microsoft Corporation Terms.

Cooksey Green

b Bing Cutnall Green StokeHeath

Move to ®

® Move to existing territory

B31_UK

© Create new territory
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Layer Menu

@  Temitory Management

Search Option

i By Territory v ‘

Select Territory

[831.uk x [ B32.UKx | B35 UK x [Ba5.UKx | ~
| B48.UKx

Fairfield

§2018 HERE. © 2018 Mirosoft Corporation Terms.

Copy to

User can select some geography(ies) of one or more territories and copy it to another plotted existing
territory or create a new territory while keeping the geography in the original territory.

Hurley

A § :

= £
‘ : N S e . Regelane e &
Search Option 5 - 3 i E: s o rtshill
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| By Territory Short S 3 = @

Select Territory : E 8 U . %

- ‘ = i) s 4 ? | .
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oln'g&"l k 6 MAPLYTICS™

Page 58 of 145




Maplytics™ — User Manual

'® Copy to existing territory
B24 UK

Create new territory
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Shape Operations in Territory Management

User can perform Binary operations on the shapes, regions or territories plotted on the map. User can
select the shapes on which they want to perform operations and right click on them to select the Binary
operations. There are five Binary options available: Difference, Intersection, Union, Union Aggregate and
Disjunctive Union. Please refer to the section of the Shape operations to know more about these Binary

operations.
Note:
e The shapes should overlap each other to be available for performing shapes operations
o There should be a layer of drawing overlapped with the shapes to be performed binary
operations on
o The required shapes should be selected before performing Binary operations
@in@%ﬁ'ﬁ"":“ 69 MAPLYTICS™ Page 59 of 145




Maplytics™ — User Manual

Multiple Territories assigned to records

If a user needs to assign more than one territory to the entity records, user can enable the feature of
Multiple Territories for a record. This feature will help the user to visualize records which lie in single or
multiple territories. After assigning the territories, they can plot the territories to visualize the respective
records lying into them.

To start using the feature of Multiple Territories for a record, user can follow the steps mentioned below:
Step 1: Enable Multiple Territories

Go to Settings > Maplytics > Maplytics Configuration Details > Default configuration detail record >
Configuration option > Select ‘Enable Multiple Territories’.

Note: User cannot undo this option, once selected and saved.

Step 2: Creating N: N relationship of entity with Territory.

Go to Settings > Customizations > Customize the System > Entities > Select Entity > N: N Relationships >
New Many-to-Many Relationship

Step 3: View the list of territories assigned to a record

Territories +
User can add a sub-grid to show the territories that an entity e Ay
record is associated with. This step is optional, even if a sub Sales 3
grid is not added, the assigned territories will get associated Services Territory

with the records in background.

Step 4: Select relationship for the field ‘Territory Relationship’ in Attribute mapping section of Entity
map.

Go to Settings > Maplytics > Entity maps > Attribute mappings > Territory Relationship > Select ‘Entity -
Territory’ relationship
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Step 5: Assign territories to records

User can either run Batch Processing tool or the Inogic.Maplytics.AssignTerritoryWorkflow on the
records to assign the territories to the records.

After assigning the territories, user can choose the Search option of ‘By territory’ to plot the territories
along with the respective records. The below screenshot shows a record plotted on the Detail map along
with the two overlapping territories which are assigned to the same record.

8 POI ¢f DIRECTION $

%

Layer Menu Lmd-en':;@:" 7
e s 2 . 7 > g

@ Plot Records

[ Cluster map
Search Option

I
| By Territory

Select Territory
?jsales 3

== 7
|Services Territory

Select Datasource

| Accoun ¥ | ‘_AII Accounts

+
Select Category

| Account || Select Cate¢ ¥ |

Select Overlay
[WSeIect Overlay

-+

Save Template
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Detail Map on CRM Dashboard

To include the Maplytics Detail Map component on the Dashboard, click on the ‘new’ button and select
‘Add Web Resource’. Select ‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource. The User can
further modify this web resource by including some custom parameter. For Example, if the user wants to
plot a route from a dashboard like Appointment Planner. The user can automate the complete process.

Add Web Resource 7 x

Add an existing web resource to the Form.

Genera Formatting Dependencies

— Web resource

Web resource ™ ﬂ kl_/Maplytics/Maplytics.DetailMap.htm ‘ﬂ

— Field Name and Properties
Name * WebResource_ |[Route

Label * Route

Display label on the Form

— Visibility

#l visible by default

— Web Resource Properties

Appointment Planner||Dashboard|jtrue

Custom Parameter{data)

Restrict cross-frame scripting, where supported.
Pass record object-type code and unique identifier as parameters

[+ Enable for tablet

OK Cancel

Custom Parameter(data) : You need to provide the Custom Parameter(data) as
e <Dashboard Name>| |dashboard| | true
e Appointment Planner||dashboard| |true
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Saved Template Visualization on CRM Entity Form

Users can include the Maplytics Detail Map component that loads a saved template associated with the
Entity record on the Entity Form. For this, the user needs to create a ‘Template’ lookup field on the Entity
form where user can select the required Maplytics Template. The user also needs to select the name of
that field in the ‘Template’ field under ‘Define Attributes’ section on the Entity Map for that particular
entity.

ENTITY MAP
account

General  Attribute Mappings Tooltip Mapping  Category Configuration  Configuration — Advance Settings  Related

Title * Contextual Search Tax Exempt Numb)
| Account Name |

Template

| Land Area |

On the Entity form, the user needs to ‘Insert’ a new Tab and select ‘Add Web Resource’. Select
‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource. The user now needs to add a Custom
Parameter for the saved templates.

e Custom Parameter (data): Provide the Custom Parameter(data) as savetemplate

Web Resource Properties ? X

Muodify this Web resource’s properties.

Gzneral Formatting Dependendies

[~ Web res

 Wisibility

[~ Web Resource Properties

savetamplats

Custom Parameter(datz)

innovative logic
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Now, when the user selects a Maplytics Saved Template on the ‘Template’ lookup field on the Entity form,
the selected template will be plotted on the Detail Map component added on the Entity form.

° A. HANSA PERSAUD & SONS

Summary Map Project Price Lists  Details  Field Service  Scheduling Related

Ticker Symbol

Relationship Type

Product Price List

Template %

Bl Land Area

ACCOUNT Annual Revenue No. of Employees
A. HANSA PERSAUD & SONS $366,466.00 v

$366 4 (
$500,400.U0

Summary Tab Map Project Price Lists  Details Field Service  Scheduling  Related

9 DIRECTION

50 feet 20m

©2018 HERE. © 2010 Microsoft Corporation Terms
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Point of Interest (POI) Locations

1
QPLOT

Winslow

Heath and Reach

Ability to search for any points of interest (POI) like ATMs, restaurants, hotels, coffee shops, etc. in the
vicinity. This will be plotted alongside the CRM data.
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Apart from plotting POI data, Maplytics also allows the user to add millions of businesses in Dynamics

CRM record as lead, account, contact, or any custom-built entity by using the Create New Record option
in the POI card or Contextual menu. (Refer to Contextual menu section)
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Routing Management

Another important feature of Maplytics is Routing across multiple waypoints. All the routing features in
Maplytics can be accessed from the Directions Card.

Merged Route and Plot View

Now, when the user plots the data and then creates a route, both the plotted data and the route will stay
on the map for an easy Route Management. This makes it easy for the user to add more waypoints to the
route without switching between Plot and Directions card.

L@ s

0SS

V
Layer Menu

s —

E Plot Records

¢ Directions

0:+=000

“ Options

= o HERBERT BROOKS 170 SLOA
| = @ | 7OLD PARK LANE LONDON W
= SUITE 23032 8 SHEPHERD MA

= 15 BERKELEY STREET SEVEM

Hyde Park

The Serpentine

| = STRON HOUSE 100 PALL MAL

4 N
= 9 GOLDEN SQUARE LONDON 7 QED'PARK LANE S

N - LONDON WIK1QRUK
= @ | 29-30, FRITH STREET LONDOI i St demess Pack
’.‘ o
= LOWER GROUND CASTLEWO X (; < @ 3

@ Add

ey ® I swr
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\§ &
@© Leavenow v [ A30s} ® A
% v A &
\ Y Victoria &
® &
® Z &
~ Open Saved Routes > \/ @ 5 Industriol [ a3 IS
| & \ oo [ 202} Estate %
= . S rm— v i 3
B X %, X § BOmptor B % e PmLIcO & LAMBETH o\%e %
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Note: The route will remain on the map unless the user clicks on the ‘Clear Route’ button or closes the
Directions Card
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Directions Card

Directions card provides the user with all the routing features. The user
can open the Directions Card directly by clicking on Directions tab.

¢f Directions
The Directions Card also opens up when the user adds a waypoint(s) to ©:+ =
the route either through the Contextual Menu, ToolTip Card or using the “ Options
‘Add to Route’ mass action. User can select the required waypoints and i@ [Fom
the leaving/arriving time. @™
@ Add

Q=000

=~ Options

Once the user clicks on ‘Go’ the

destination

@ Feavenow >

¥ Open Saved Routes
Select Start Date *

;0 218 at FINLAY STREET Staten .
@ [oeoREEere route will be plotted and the SecEd Do
- @ | 7327 st AMBOY ROAD Sisten directions will be available on the
-@ 8514 at AMBOY ROAD Staten D|rect|0ns Card.
- e 85 at GOFF AVENUE Staten Is
&) Add
leavest | Amieby Note: The user can add a maximum of 25 waypoints in the direction
1 15 AM functions.

September 2018 >

Su Mo Tu We Th Fr Sa

©

16 17 18 19

S

21

NN
N

[SEN)
@

23 24 25 26
30

5
[N
@

~ Open Saved Routes

Once the waypoints are selected, the user can choose the mode
of transports like Driving, Walking or Transit to view the route.
The user can select different options to reduce the time, toll,
highways, etc. by clicking on the Options button. Some of these
can be auto-selected using Maplytics Configuration Settings.
The user can drag and drop the waypoints to change the order
of route.

@ihig"%"‘i"&“ 6@ MAPLYTICS™

Q:r2Q@®

¥ Options

& Miles ! Kilometres

® Shortest Time U Shortest Distance
¥ Optimize Directi... || Avoid Highways
) Avoid Toll Roads L Traffic

) Along The Route
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Optimize Direction

»® Directions

This can be selected from the Options. This option
will provide the users with the optimized route

1 e $ M 9 @ @ direction between their waypoints keeping Origin &

Destination as fixed waypoints.

T Options
® Miles ) Kilometres
® Shortest Time (Z) Shortest Distance

¥ Optimize Directi... I [ Avoid Highways

[J Avoid Toll Roads [ Traffic
' [ Along The Route

Route Sharing ¢® Directions

Maplytics also helps the user to share a route in
different ways.

=R =) =Y
Email Route:

« Options

e Route link
Email Related

To & Gabriele Cannata

Ce

Bee 1 A Datum Fabrication

Subject Route link

Designer | HTML | Preview 9 < v

BEER=z==s/QhE 9= B =
B I U S x, x| T, | Stes - | Format ~ | Font - | size - A- B Q

Hi,
Please use the below link to access route in Desktop / Laptop:
hitps://maproute.page.link/vh3M

For Smartphone / Tablet user, please use following links:

1. Show Complete Route

2. 151 Taylor St, New York, NY 10310 - Lighthouse Ave

3. Lighthouse Ave - 126 Kelly Blvd, New York, NY 10314

4. 126 Kelly Blvd, New York, NY 10314 - Bloomfield Ave, New York, NY 10314

The user can email the route to any of the Dynamics CRM records using email route option.
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Save Route:

Save The Route x

© Add to existing route

o? Directions

O+ = Q@@

~ Options

'® Enter the route name

| 9-Oct-2018|

Select route date *

2018-10-12
Users can also save their route plotted. The route record will

also save the information like number of waypoints, total
distance and time for the route. User can add the route to Select User
an existing route or save the route with a name & owner as

a new route. m

[ . .
User can also update any route directly using the update

button. User can search for route existing in the required
duration and click on the update button besides the
required route.

Owner

Sam_06 Oct 2018 Update
10/6/2018 1:56 PM

Sam_08 Oct 2018_Premium Update
Leads

10/8/2018 7:08 PM

William 6 Oct 2018

10/6/2018 1:57 PM

William_08 Oct 2018_Open

Cases’

10/8/2018 7:08 PM

Clear Route:

2® Directions

The user can use the Clear Route button to clear
the route from the map. This will just clear the

route and directions card will still be opened for e Y = e @

further use.

~ Options

Default Origin and Destination
User can set default origin and destination for Route management.
Go to Settings > Maplytics > Maplytics Configuration Details > Record of the user
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o Maplytics

General Auto Scheduling  Related

Defaults
Map Mode Road Flot Data Non Cluster

Along The Route

Distance Unit Mile
! Distance 500
Optimize Direction No Default Location 50 Perkiomen Ave, New York, NY 10312
Live Traffic No Records Per Page In
Grid %
Route Option Shortest Time Zoam Leve
£ Map Center -
P & User © 0 Peter Ashton
Heat Map Type Boundary Maplytics Security .
Template B rield Sales
Summary Grauping City .
Set As Destination Other
Default Template <] Proximity - 3 Miles Other - Set As 382 Arthur Kill Rd, New York, NY 10308 -
Destination
Set As Origin Other
| Other-Set£sCrigin 10 Venus PI, New York, NY 10312 | ¥

There are six options to select:

e User Mailing Address - Reads address from User mailing address

o User Other Address - Reads address from User other address

e Business unit Bill to Address - Reads address from logged in user’s Business units bill to address
Business unit Ship to Address - Reads address from logged in user’s Business units ship to address
None - If user do not want to set default origin/destination

e Other : It will have its own multiline textbox associated where user can enter their own address

Note: If a user uses the “Plot route” button to plot a “Route” activity record on the
Detail map, the Default origin/destination will not be set in the Direction card

Snap waypoint
This helps the user to edit a plotted route just by dragging the route to the required point on the map.

Drag to a location: User can drag a point on the route to a required location on the map. This will add the
location as a waypoint at the dragged point in the route. This will also update the Directions card with the
newly added waypoint.
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Drag to a pushpin: User can also drag a point on the route to a pushpin plotted on the map. This will
detect the record and add the record’s location at the dragged point in the route. This will also update the
Directions card with the newly added waypoint.
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Along the Route

This feature provides the user the ability to search the records
that fall in the defined proximity along the route. The default
value for Along the Route search can be configured in the
Maplytics Configuration record. This will find all the records
with the defined search parameter and that falls in the entered
proximity along the route.

~ Options
* Miles

® Shortest Time

¥ Optimize Directi...

Avaoid Toll Boads

Kilometres
Shortest Distance
Avoid Highways
Traffic

¥ Along The Route |5 Miles

Note: The user can add the value between 0 — 25. The user can also add a decimal values with a scale
of 2 for the radius.

bk
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The Along the route records is also saved when the user saves the route. However, if the user has selected
multiple Datasources on the Plot Card, only the first Entity and View combination in the Select Datasource
will be saved for along the route search in the saved route.

If the user has plotted data on the map and opens a saved route that has along the route parameter saved
as well:

@.ru:us.'tg: &9 MAPLYTICS™
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If the user open the Directions card directly without plotting the
data or opens a saved route without the along the route
parameter saved, they have the option to select the Datasource
for the Along the route search directly on the Directions Card.

Maplytics™ — User Manual

The user can either click on ‘OK’ to
clear the plotted records and
search along the route records
with the Datasource saved in the
route.

Or, the user can click on ‘Cancel’
to search along the route records
with the existing plotted data,
ignoring the Datasource saved in
the route.

U

i

® 00

(* Add

®

l‘ Leave now ¥ n

~ Open Saved Routes

1 5 10 min without
sriri traffic 6
Via Finlay St,

7327 at AMBOY ROAD Staten It
6514 at AMBOY ROAD Staten I

85 at GOFF AVENUE Staten Isl:

destination

Heavy traffic 2.9 mi

Carteret St

From . .rm.dynamics.com

This action will clear the plotted records and will plot the Datasource
saved in the route.
Click 'OK’ to continue Or Click ‘Cancel' to plot the route using the

existing search critera.

¥ Options
* Miles Kilometres
® Shortest Time Shortest Distance

Optimize Direction Avoid Highways
Avoid Toll Roads Traffic
¥ Along The Route 5 Miles

Select Datasource

Aecount ¥ || Selert Vie

Route Redirect and Copy Route Links

After plotting the route, user can use the ‘Redirect’ button
to open the ‘Navigation Links’ popup on the browser as well
as the Dynamics 365 App for Phones and Tablets.

The user can click on individual links for route navigation from point A—B, B—C, and so on. User can also
select the application within the User Configuration record to navigate the route. Refer the section of
‘Maplytics Configuration Details (Personalization)’ in the installation manual to select the application.
These links will redirect the route to the app selected in the configuration.

©

innavative logic
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Redirect with Google Maps

User can view the turn-by-turn navigations on Google Maps site
on desktop and Google Maps App on Phones and Tablets. User
can also choose to view the complete route.

Note: The maximum waypoints to show the complete
route is 10 waypoints.

Redirect with Waze

Navigation Links x

For turn-by-turn navigation, please use the
following links

Show Complete Route

From: 22 Depew PI, New York, NY 10309
To: 994 Arthur Kill Rd, Mew York, NY 10312

From: 994 Arthur Kill Rd, New York, NY 10312
To: 2880 Victory Bivd, New York, NY 10314

From: 2880 Victory Elvd, New York, NY 10314
To: 218 Rosedale Ave, New York, NY 10312

User can view the turn-by-turn navigations on Waze site on

For turn-by-turn navigation, please use the
following links

desktop and Waze App on Phones and Tablets. This will show

the navigation links from current location to the waypoints.

From: Current Location
To: lsmael Tadao

From: Current Location Note: The check points should be under 3000 miles from the

To: Estela Gopaul

current location to view routes on Waze.

From: Current Location

To: Mathilda He

From: Current Location
To: Rachele Babaev

From: Current Location
To: Vennie Tsitiridis

Redirection on mobiles: User can click on the route navigation
buttons to redirect on the Google maps/Waze.

The user can also use the ‘Copy Links’ button to copy the links to
send them as an email or save it into a note.

(o) MRS &P MapLYTICS"

Navigation Links b

For turn-by-turn navigation, please use the
following links

From: South Brunswick Township, NJ I:I
To: 420 Swedeland Rd, Upper Merion

Township, PA 19406

From: 420 Swedeland Rd, Upper Merion I:l
Township, PA 19406

To: Deakyneville Rd, Townsend, DE
19734

From: Deakyneville Rd, Townsend, DE |:|
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Note:
e By default the Links will be redirected in Google Maps.

o The links redirect on the Dynamics 365 App for Phones and Tablet works with Dynamics 365
v9.x

Print Route

Using the ‘Print button’, the user can print the
Directions as well as the adjoining Map. After the @ PLOT S POI ¢? DIRECTION
route is plotted, user can click on the ‘More Options’
button to open the ‘Print’ option and click on the
Print button to print the route.

D -
@ PLOT S Pol ¢¥ DIRECTION

012000
¥ Options
- @ Miles (¢}
p ® Shortest Time © Shortest Distance
§ | ¥ Optimize Direction £ Avoid Highways
O awidTollRoads [ Traffc
[ Along The Route

{ = @ | 25Giroy St New York, NY 102
.
[Rommane |

ichmond Ave

o R X
o i v

® Add

4 Open Saved Routes

49  Heavytrafic: 20 min 102 mi
Via Huguenot Ave, RT- e
440N - Local roads
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Clicking on the Print button will open a new window with the map and directions
on the page which can be seen in the below screenshot:

Click on the Print Icon to print the map and route instructions.

Note:
e Routing requires a minimum of two waypoints to be provided.
o A4 size paper with landscape mode is recommended while
printing.

Download map
Using the Download map button, the user can download the map as visible on
the screen

o
¥ & print
o X
Westfield rantora—| = ViewData

i
16, 73274 N

baing 3
Driving Directio

iausach
o
- (2168 He i
Otlingérsrat
iotzinge cY
Metzingen Loy el S
eutlingen

Langanad Grmery, G

esternauf

A |& Territory Management |
-
w’nﬁeld }f

- ~ Garwood
L4
5

Fanwnaod

Note: Download map is not supported for Internet
Explorer.

Auto Scheduling

Auto Scheduling helps users to plan an optimized schedule to follow on the field. The user can decide the

required set of customers to meet, the preferred date and time to cover all the meetings and the number
of working days. Auto scheduling will provide an optimized schedule which includes the routes to follow

each day based on the details entered by the user and option of creating activities for the same.

User can plot the Entity records on the map that are needed to be visited. User can open the view grid to
check the number of records plotted on the map and deselect the records that are not required.

Note: Auto Scheduling can be performed on a maximum of 100 records plotted on the map

After plotting the required records on the map, user can Go to Mass actions > Auto scheduling. This will
consider all the records that are plotted on the map and will proceed to plan a schedule.
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Note: The visibility of the option of ‘Auto scheduling’ into Mass Actions will be based on the Maplytics
Security Template assigned to the user. Please refer to the section of ‘Maplytics Security Template’.

Auto scheduling card
User can set the preferred values to be considered while scheduling a plan.
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@ Auto Scheduling
Start Date *
09/29/2018
Start Location *
104 Kell Ave, New York, NY 10314
End Location

104 Kell Ave, New York, NY 10314

Period *
1 Week
Duration *

30 Minutes

Start Time *

08 M 00 v
End Time *

05 v 00 v
Break *

01 hd 00 4

Break Duration *
60 Minutes
Buffer Time *
10 Minutes
Working Days *

¢ ¢ @ ¥ @
Su Mo Tu We Th Fr Sa

AM

PM

PM

Maplytics™ — User Manual

Start date: The preferred date to start the schedule

Start Location: The starting location for every day’s route
End location: The ending location for every day’s route
Period: The number of days the user wants to cover the
meetings in. The meetings will be distributed among the
days selected in period on the basis of optimization of
routes. User can choose any one options of the following:

e 1 Day
e 2 Day
3 Day
4 Day
5 Day
1 Week
2 Week
3 Week
1 Month

Duration: The time frame required for each meeting. User

can choose any one of the following options:
e 5 Minutes

10 Minutes

15 Minutes

20 Minutes

30 Minutes

45 Minutes

60 Minutes

75 Minutes

90 Minutes

e 120 Minutes

Start time: Starting time to start the schedule of each day. User can enter the time in 12-hour format
(hh:mm)
End time: Ending time to end the schedule of each day. User can enter the time in 12-hour format (hh:mm)

Break time: Starting time of Break during each day. User can enter the time in 12-hour format (hh:mm)

Break Duration: Duration of the break during each day. User can select any one of the following options:

©

e (0 Minutes
e 5 Minutes
e 10 Minutes

e 15 Minutes
e 20 Minutes
e 30 Minutes
e 45 Minutes

innovative logic
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e 60 Minutes
e 75 Minutes
e 90 Minutes
e 120 Minutes

Buffer time: User can add extra time to the schedule as buffer to use in unforeseen situations without
changing the schedule.

e 5 Minutes

e 10 Minutes

e 15 Minutes

e 20 Minutes

e 30 Minutes

Working days: User can select the days that will be working and should be considered in the plan of Auto
scheduling. User can select any day between Sunday, Monday, Tuesday, Wednesday, Thursday, Friday,
and Saturday. At least one day should be selected.

10e 5
Auto Scheduling

o 5 SherigaL& Sons
(0K}

W< )
104 Kell Ave, New York NY i Qﬁ

5 Nicolosi & Sons
Spaeth & Sons : 1] 2
Incantalupo & Sons Panicss SOL _

104 Kell Ave, New , @
York, NY 10314 s

Prendamano & Sons

104 Kell ive, Newmmms 2
York, NY 10314

Pellegrete & Sons

Spaeth & Sons

I}
L
E
Scavonne & Sons =
Pellegrete & Sons ’,: E) Prendamj no & Sons

2 & Sons
Naso & Sons %\ ;_

Dapico 2 Sane
2

0
6]
(C]
0]
@ Spencer Sons
(F]
(6]
0

I—— ——————————
——
N Ee————

== st

" f; E Hide Data

¥

Schedule for 10:01/2018 (10)

G g

User can click on proceed to get the optimized routes for each of the working days considering all the
values provided in the Auto Scheduling card. The waypoints of the routes will be shown in the Direction
card. Users can also view the details of the waypoints in the view data grid
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Transition bar: User can use the transition bar to view the route

planned for different days. User can either click on the arrow
buttons to go to the previous or next day plan. They can also select
the date to go directly to the date required.

f.i.?«'JD

lort Johnson

Su M
| St

o Tu We Th

1 2 3i| 4

Fr Sa

5

6

Create Activities: User can create activities for the schedule planned. The user can create the followings:

e Appointment
e Service Activity

e Bookable Resource Booking

User can also select the option of ‘Create Route(s)’ in order to save the planned routes into ‘Route’ Activity

Entity.

Creste pctes

Select Activity

Name

End Date *

Resource

Sam

Booking Status *
In Progress
Booking Type ~

olid

¥ Create Route(s

Bookabie Resourt

ce Booking

Select Activity *

Appointment

Subject *

Premium clients
Start Date *

2018-10-01
End Date *

2018-10-09
Owner

Sam
Priority

High

| Create Route(s)

Note: To make the option of Bookable resource booking visible, the user needs to create a relation

between the respective Entity and Bookable Resource Bookings.

innavative logic
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Go To Detail Map: Using this button user can go back to the Detail map.

:’:’T?
E

Note: All the scheduled data will be cleared, if ‘Go to Detail Map’ button will be
used

Configuration details for Auto Scheduling

e User can set the default settings for Auto Scheduling in the Maplytics Configuration Details.
Go to Settings > Maplytics > Maplytics Configuration Details > Configuration details record for
the user > Auto Scheduling

MAP COMFIGURATION DETAILS
Maplytics

General  Auto Scheduling Related

feriod 5 Day Working Days
~ ) Sun
Duration 30 Minutes
) Mon S
Start Time 9:00 AM
- ) Tue )
End Time 6:00 PM
Wed CJ
Break 1:00 PM
Thu =)
Break Duration 30 Minutes
n )
Buffer Time 15 Minutes

Auto Scheduling Option

Schedule first activity
at start time

e System admin and Maplytics admin can set the start time as the default start time for the first
activity.
Go to Settings > Maplytics > Maplytics Configuration Details > Default Configuration details
record > Auto Scheduling
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MAP CONFIGURATION DETAILS : INFORMATION

Maplytics =

» Advance Settings

Search Options

Proxy Settings

Auto Scheduling Option

I‘,:'e"e“:ta:h' at start time v l

Note:
e Auto Scheduling cannot be performed on Activity entity records

e Create Activities for Custom Entity:
o A custom entity should be linked to any OOB Entity into Entity Maps in order to

Create Activities for the Entity
o If a custom entity has its own address, the option to create Appointment and
Service Activity will not be available. The user can only create activity of Bookable

Resource Bookings
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Check-In/Check-Out

Check-In feature enables users to register their arrival and departure time for the Check Points while
navigating on field with the help of Check-in and Check-Out buttons. These buttons will help to tag the
geo-coordinates of the location while a user is visiting a meeting. This will also help the management to
track the activities of the field professionals as well as the time they have spent on every meeting.

Configuration

To get started with the feature of Check-In, the first step is to configure Maplytics. Configuration will
create the Entity Map for the Check-In entity. Please refer to the section of ‘Configure’ under the ‘Initial
Setup - Maplytics License Activation, Configuration for Entity Map, Dashboards and Census data’ within
the Installation manual.

This feature can be enabled for any OOB or custom entity within their respective Entity Maps. To enable
this, System Admin/Maplytics Admin can follow the steps mentioned below. The following screenshot

shows the entity map of Appointment for an instance.

Go to Settings > Maplytics > Entity Maps > Open Required Entity Maps Record > General Tab > Enable
Check-In > Set the value to ‘Yes’ & click on ‘Save’.

ENTITY MAP
appointment

General  Attribute Mappings  Tooltip Mapping  Category Configuration  Configuration — Advance Settings  Related

Entity Name * [ Appointment | Link Te [Regarding
B Total Records 22
& Geocoded Records 22 {4 Enable Check-In Yes
Note:

o The default value for ‘Enable Check-In’ is set to ‘No’.
e User cannot undo this option, once selected and saved.
e After enabling this feature, please wait for a while before using this.

View Related Check-In/Check-Out records:

User can choose to view the related Check-In/Check-Out records for the plotted records (Appointments,
Accounts, etc.) using the feature of ‘Plot Related Records’. To plot related Check-In/Check-Out records,
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user needs to select the relationship. To select the relationships, user can follow the steps mentioned
below. We have provided the steps for Appointments for an instance.

Go to Settings > Entity Maps > Required Entity Maps record > Configuration > Related Records
Configuration > Relationship List > Select appointment - ikl_checkinentity

User can also refer to the section of ‘Related Record Configuration’ under the Entity Maps within the
Installation manual for the same.

Note: User needs to select the respective Relationship with Check-in for every entity within their
respective entity maps for which they want to see the related Check-In/Check-Out records.

ENTITY MAP
appointment

General  Attribute Mappings  Tooltip Mapping ~ Category Configuration ~ Configuration  Advance Settings  Related

Related Records Configuration View Configuration
Relationship List L] View List H ¢ x
Relationship List Relation Schema Default Relations... | Views T View Type Y| Color Pushpin
spointment - annotation Appointment_Annctatio ®
appointment - annotatio \ppointment_Annotation ¥ Al Appointments System View -
appeintment - slakpiinstance slakpiinstance_appointment
¥| Appointment Planner Dashboard Record - hvid
appeintment - syncerror Appointment_SyncErrors
appeintment - actioncard appointment_actioncard ¥ My Appointments System View - hvid
appointment - queueitem Appointment_Queueltem -
¥| Wy Completed Appointments System View -
appointment - bookableresourceboo msdyn_appointment_bookableresour .
¥ Ny Draft Appointments System View - hyi
appointment - msdyn_resourcerequir msdyn_appointment_msdyn_resource v
I 4 appointment - ikl_checkinentity ikl_appointment_ikl_checkinentity I
Check-Out

After enabling the feature, user can also enable the option of ‘Check-Out’. This way the user can first click
on the Check-In button while visiting the meeting and then can click on the Check-Out button while
completing the meeting. Here, the geo-coordinates for both the locations will be saved which will also
help the management to track the time spent on the meetings.
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In order to enable Check- Out, System
Admin/Maplytics Admin can follow the steps
mentioned below:

Go to Settings > Maplytics Configuration Details >
Default Configuration Detail Record (the one with
no user name) > Check-In tab > Set the value for
Enable Check-Out to ‘Yes’ & click on ‘Save’.

Note:

MAP CONFIGURATION DETAILS
Maplytics

General Advance Settings  Check-In  Auto Scheduling  Related

I Enable Check-Out Yes I
Default Radius 0.20
Geofencing No

o The default value for ‘Enable Check-Out’ is set to ‘No’.

e User can anytime disable this option.

e Check-Out option can only be enabled for entities for which the feature of Check-In has been

enabled.

e Check-Out can be enabled/disabled only at Organization level.
e Check-Out button will only be available for the records for which the user has checked-in.

Default Radius: It is the distance that the System admin/Maplytics admin can set to consider the accuracy
of the Check-In/Check-Out records created by the field professionals. If the Check-In/Check-Out records
do not lie within this radius then it will be considered as invalid record and will be shown with a pushpin

with this Red Cross. For example: @

MAP CONFIGURATION DETAILS
Maplytics

General  Advance Settings  Check-In

Enable Check-Out Yes
Default Radius 0.20
Geofencing No

Auto Scheduling  Related

Note: By default, Geofence radius is 0.20 kilometers or miles depending on the unit set in User
Configuration Detail record.

©
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Geofencing

Geofencing is creating a virtual geographical boundary of a specified Geofence radius around a record. If
Geofencing is enabled, user needs to be within this radius to successfully Check-In/Check-Out for a record.
If the user is not within this radius, the user will not be able to Check-In/Check-Out and will be shown a
message specifying that they need to be within ‘n’ Km/Mi of distance from the Check-In/Check-Out
location. This will help the management to have only valid Check-In and Check-Out records done by the
field professionals.

In order to enable Geofencing, System Admin/Maplytics Admin can follow the steps mentioned below:

Go to Settings > Maplytics Configuration Details > Default Configuration Detail Record > Check-In tab >
Geofencing > Set the value for Geofencing as ‘Yes’

MAP CONFIGURATION DETAILS
Maplytics

General  Advance Settings  Check-In  Auto Scheduling  Related

Enable Check-Out Yes
Geofencing Yes
Geofence Radius 0.20

Geofence Radius:
After enabling Geofencing, System Admin/Maplytics Admin can set the default value for Geofence radius
which will be considered while a user Checks-In or Checks-Out.

Note:
e By default, Geofencing is disabled in which case the user can Check-In/Check-out from any
location.
e By default, Geofence radius is 0.20 kilometers or miles depending on the unit set in User
configuration Details record.
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Creating Check-In/Check-Out records:

While navigating on field user can Check-In and Check-Out against any record. This can be done in the
following two ways:

e From Record Form: User can open the required record (Appointments, Accounts etc.) and click on
Check-In/Check-Out button on the ribbon.

@ Save " Mark Complete O Refresh ﬁ@ Map @ Check-In X Close Appointment B3 Process v E Convert To = Recurrence
Appointment: Appointment Priority
Appointment for Insurance Plan B3 Normal

Appointment Tab Related

Adventure Works Electronics

Required !

Optional i

Subject *  Appointment for Insurance Plan B3
Location —

Regarding L Adventure Works Electronics

Save " Mark Complete O Refresh @ Map @ Check-Out X Close Appointment E?—' Process ™ E Convert To 7> Recurrence
- Appointment: Appointment ™ Priority
niy .
Appointment for Insurance Plan B3 Normal M

Appointment  Tab  Related

Required {2 Adventure Works Electronics
Optional —

Subject " Appointment for Insurance Plan B3
Location -

Regarding {2 Adventure Works Electronics
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inoo'\ntment: Appointm... il Appointment: Appointm... .
ppointment for Insurance PI.. Appointment for Insurance Pl...
~" Mark Complete ~ Mark Complete
) Refresh O Refresh
& Map | & Map
X Close Appointment X Close Appointment
87 Process > B7 Process >
2  ConvertTo > % ConvertTo >
= Recurrence ©~  Recurrence
[l Delete il Delete
2 Email a Link & Email a Link
Adventure Works Electronics P £ Adventure Works Electronics P
Optional Optional
je o0
Subject * Subject
Appointment for Insurance Plan B3 Appointment for Insurance Plan B3
«c = a p @ - « = e £ @

Note:

User needs to allow to read the GPS location of the device in order to Check-In/Check-Out.
The Check-Out button will be available in the place of Check-In button after the user
Checks-In.

e Through Detail Map:User can click on any plotted records (Appointments, Accounts etc.) to open
the Tooltip Card and click on the Check-In/Check-Out button.

innovative

noGi

k&ic

¥ AMC Discussion

¥ AMC Discussion

= DIRECTION =p SETASCU. =p SETASP.. = DIRECTION =¢ SETASCU...

= SETASP..

340 228 Ave. NE Sammamish WA 98074 USA 340 228 Ave. NE Sammamish WA 98074 USA

Subject: AMC Discussion Subject: AMC Discussion

Regarding: Trey Research Assembly Regarding: Trey Research Assembly
Priority: High
Start Time: 18-07-2019 1510

End Time: 18-07-2019 15:10

Priority: High

Start Time: 18-07-2019 15:10
End Time: 18-07-2019 15:10
Appointment Type: Not Recurring i )
Appointment Type: Mot Recurring

Take An Action

OO

Take An Action
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-+ DRECTION = SET AS CURR

-+ SETAS PO,

Priority: -
Start Time: 15:07-2019 1510
End Time: 18-07-2019 1510

Appointment Type: Not fecuiring

Take An Action

Note: Multiple Check-In/Check-Out records can be created for any record (Appointments, Accounts, etc.)

Visualize Check-In/Check-Out records on Detail Map

To analyze the activities of field professionals, Check-In/Check-Out records can be plotted on the map
like other entity with the help of the Plot Card. User can select ‘Check-In" as the Datasource and select a
required view to visualize the records from that view.

@  Plot Records

[ Cluster map
Search Option
- Select View
By Location System Views

Active Check-Ins

Active Check-Outs
Check-Ins This Month
Check-Ins This Week
Check-Outs This Month
Check-Outs This Week
Inactive Check-Ins

[l Show Travel| Inactive Check-outs

My Check-Ins This Week
My Check-Outs This Week
Today's Check-Ins
Today's Check-Outs

Check-In T | selectview ¥

+

Current Location

Proximity

® Distance

Select Datasour;
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Willows. Avondale

Juanita

h . BLUE RIDGE f
| @PLOT  GPOI o9 DIRECTION § (3 o )
K y 1 |
| CREST! J Eari EDUCAT

| (s08

Layer Menu
GREEN LAKE! w ¥ Kirkland
| J (508)
. |

@  Plot Records
Ballard |
Phinney | |
[ 'WINDERMERE

Cluster map

Search Option
By Location denl] &
nion
3 | Bay
Current Location PORTAGE BAY. ) Y Yarrow Point |
Loipersdorf bei Furstenfeld 271, 8282 @ INTERBAY @ | oS g |
Hunts.Point |
BROADMOOR Cydetil  Y)

I

Proximity
18 ® Distance Time @
Show Travel Distance e
® Medina Vo
v - V @ | Bellevue LAKE Hil
Seattl |
a0} Lake Sammamish

g Kilometres
b MINOR
Select Datasource Elliott Bay A
) \ : \
) MEYDENBAUER
- ATLANTIC |
N Roanoke 1l

> Q) i AN h
eaux Arts
® AN

Plssiupressag,

Robinswood
Monohan

Check-In ¥ || Active Check ¥

+

Select Category

Lake Washington \
"‘Q’ e ———— O, Pin
/ Eastgat
i w, West Lake
Sammamish
PROVIDE!

Check-In | | Select Cate¢ ¥ !
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Select Overlay |
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) N View Data

b Bing

Analyze Check-In/Check-Out records
After plotting the records for Check-In and Check-Out, user can analyze the pushpins by distinguishing

between the following two kinds of pushpins:
e Valid Check-In/Check-Out: When a user Checks-In/Checks-Out within the Default Radius or

|’.‘|
Geofence Radius, it is a valid record and will be represented by v pushpin.
Invalid Check-In/Check-Out: When a user Checks-In/Checks-Out outside the Default Radius it is

represented by @ pushpin.

Visualizing Related Records
After plotting the records for Check-in, user can also choose to view the records(Appointments, Accounts
etc.) against which the plotted check-ins and check-outs were created.

Visualizing Related Record for Check-In/Check-Out records:
After selecting the relationship, user can choose to view the related record for any Check-in and Check-

Out record plotted on the map.
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25th Ay

Ravenna Ave NE

R Layer Menu

Plot Records

17th Ave |
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a0y 1512
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>
H

L Check-in Record

20th Ave NE

NE 47th St
z
s E Related Record
: 2
z o 3 o
T 2 = &
£ 2 B s
2 N 46th St < by NE 46th St <
UNIVERSITY. NE 45th S
DISTRICT
5
a
= NE 44th St
<
Z
o NE 431
: L 2
s s g S 3
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b>8ing o View Data €20

S

The related record can be visualized in the following two ways:

e By Contextual Menu: User can right click on any Check-In/Check-Out pushpin to open the
‘Contextual menu’ and click on ‘Show Related Record’. This will plot the related record for the
selected pushpin. To hide the related record, user can again right click on the same Check-
In/Check-Out pushpin to open ‘Contextual Menu’ and click on ‘Hide Related Record’.

¥

@ o %)

D.pe-ﬁhl.:e\r:.cord I Open Record
Show Related Hide Related Record
— Directions [ @
Directions I+ L

Add To Route
ne{ Add To Route

Set As Current
Set As Current

. Location
Location
Set As POI Location N Set As POI Location
Actions > Actions >
Save Settings W Save Settings >

e By Tooltip Card: User can click on the Check-In/Check-Out pushpin to open the Tooltip Card and
click on ‘Show Related Record’ from the ‘Tooltip Card Actions’. To hide the related record, user
can again click on same Check-In/Check-Out pushpin to open the Tooltip Card and click on ‘Hide
Related Record’.
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¥ account-City Power & Light ...

= DIRECTION =# SETASCU.. =p SETASP..

D-16/2, Sanpada Midc Road Navi Mumbai MH ...

Name: account-City Power & Light Integration
Owner: Sam K

User Latitude: 47 66669

User Longitude: -122 19854

Created On: 18-07-2019 11:54

account: City Power & Light Integration

Take An Action

clep

Show Related Record !‘ q_‘
\

¥ account-City Power & Light ...

=» DIRECTION =+ SETASCU.. =p SETASP..

D-16/2, Sanpada Midc Road Navi Mumbai MH ...

MName: account-City Power & Light Integration
Owner: Sam K

User Latitude: 47 66669

User Longitude: -122.19854

Created On: 18-07-2019 11:54

account: City Power & Light Integration

Take An Action

g

Hide related record [ I'_

Visualizing related Check-in/Check-Out records for plotted records (Appointments, Accounts, etc.)
After selecting the relationship for the required entity within the entity map as suggested above, user can

click on any plotted record to open the Tooltip card and click on ‘Plot related record’ to plot the related
Check-In/Check-Out records.

@,

¥ The Phone Company Integr...

= DIRECTION = SETASCU.. =p SETASP..

2624 NE University Village Street Seattle WA ...

Take An Action

wlie ) 2 foX =Y & e

MOGIC

Plot Related Records b4

Select the relationship to plot related record

[ appointment - ikl_checkinentity (ikl_appoint._..
I
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& POl ¢? DIRECTION

-

Plot Records
v:dl AMC Discussion
¥ Related Records

@ ikl _appointment ikl _checkinentity @ ’

NE 6th 5t

Heat Map

Clicking on the Heat Map command button will bring up the Heat Map Screen.

Westfield

;’ H & Heat Map

Select Datasource z Y & j 3 L
By - - STARLINGTON |

! Account ¥ ‘ My Active Accounts ¥ | < 4

¥ Select Measure

i
- ‘ Annual Revenue

| Select Category |
- ; - ) 3 | avenve
Ave | Industry : " | GRAVESEND | ;

Please Select Region Type

| PostalCode

%1 Select Display

r £
lBoundy |}

Ll
=,
Ige’ ¢

S
B
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This option helps the user to choose the Entity and view combination to analyze the data.

Select Measure:

This helps the user to define the aggregation method to be used to color code the region. By default, it is
based on number of records (i.e. ‘By Count’). The user can change this to any other field attribute from
the drop-down. Dropdown contains the list of all numeric and currency fields.

Select Category:

This option helps the user to filter data. The user can modify the search result using selection in the

Category option.

> Bing

£9% ’EDL ‘

5
g@@

(3 View Data #2517 HERE & 2917 Werosah Campraton Terms

Select Region Type:

This option helps the user to define the geography level for aggregation. The user can choose any option

from the drop-down:

o City

e State

e County
e Country

e PostalCode: The smallest postcode category, such as a zip code.

e PostCode Sector: The second ‘1’ is called “Postcode Sector”. Example: CA1 1

e PostCode(Outward Code): This is called Outward Code, the part of the postcode before the single
space in the middle. Example: CA1

e PostalCode Areas: The next largest postcode category after Postcodel that is created by

aggregating Postcodel areas.

e Territory: This option will use the Sales Territory defined in Dynamics CRM.

Note:

e The regions that were plotted using the option Post code Areas before will now be plotted by
using the option of Post code sector.
e The regions will be plotted as per the Bing maps.

® innavative logic
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The default option is to summarize the addresses by City. You can find the default settings on the
Maplytics Configuration record for the individual user as shown below:

o Maplytics

General Advance Settings

Check-In Auto Scheduling  Related

Optimize Direction No
Live Traffic No
Route Option Shortest Time
£ Map Center -
Heat Map Type Boundary
Summary Grouping City |
Default Template -
Set As Origin Other

Other - Set As Origin

Select Display

10 Voie des Vaches, 08450 Angecourt

Default Location

Navigate Within

Records Per Page In
Grid

Zoom Level

B User

Maplytics Security
Template

Set As Destination

Other - Set As
Destination

Loipersdorf bei Firstenfeld 271, 8282 Loipersdorf bei
Fiirstenfeld, Austria

Waze

50

Other

Mont-devant-Sassey, Meuse, France

There are four options available to analyze data on Heat Map. Default Heat map display can be selected
using Maplytics Configuration Settings.
e Boundary: This will create Heat Map on basis of selected region type like City, Postal Code,
Country, State, Territory, etc.

(0 innovative logic
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B

Industry

Select All

®|®

Blank

Y

Others

3]

Accounting

®

Banking

®

Consulting

<

Consumer Services

®

Engineering

=

Financial

3]

Insurance

Y

Social Service

Summary Card

No Boundary: This option does not consider the region type. It simply creates a Heat Map by the
density of the measure selected without geographical boundaries.

J) Heat Map

Select Datasource

T
| Account ¥ || Active Accounts

Select Measure

Annual Revenue

Select Filter

| Industry

Select DlspEy
No Boundary

Industry

Summary Card

Pie chart: Users can view the data in the form of Pie charts based on the heat of the attribute
selected in the Measure and Filter. Pie charts help the users to analyze the data on the basis of
comparative data shown by the Pie charts on the map.
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v
v
v
v
£
L
R4
v
b4
R4
v

Summary Card

e Column chart: Users can view the data in the form of column charts plotted on the basis of the
heat of the attribute selected in the Measure and Filter. User can easily analyze the plotted data
on the basis of the proportions shown by the respective columns.

o Hover: On hover, it shows the details of that Boundary/Pie chart/Column chart
o Summary Card: The user can click on any Boundary/Pie chart/Column chart to get the
summarized information of the same.

@lh‘%&k GOMAPLYTICS" Page 97 of 145




Maplytics™ — User Manual

Samenary Caed

Total Records: 5673
Anreal Revenve (Sum)
$1.596.400.821.00

No. of Employwes (Sumi: 000

Btarkc 1
Anral Revenwe (Su= $000
No. of Employees (Sumi 000

Accounting |
Anmal Revene (Sum §85.282.00000
No. of Employwes (Sumy 0.00

Banking 117
Anmeal Reverwe (S §60.402.730 00
= No. of Employees (Sumy 000

Beokers |
Aneraal Reveous (Sumy §342 65200000
No. of Employees (Sumi 000

Buniness Services 17
Ancmasl Revenwe (Su=i §18448250000  «

Total Pecords 563

Anrwal Reverwe (Suml
$1.596408321.00

No. of Employees (Sumk 000

Blank |
Anreast Revenus (Susk $0.00
No. of Employews (Sum) 000

Accounting 7
Anneal Revence (Sumi $85.282.000 00
No. of Employees (Sumi: 000

N Banking 117
Annsal Revenwe (Sumi §60.403 73000
No. of Employees (Som: 0.00

Beokers |
Anewal Revesue (Sus) §188653.000.00
No. of Employees (Sum) 000

Business Services |
Anrast Reveace (Sum) § 184 442 500,00

Note: If Pie chart/Column chart is selected as the Display type, the option of Territory under Region

Search:

Clicking on the ‘Search’ button will plot the addresses of all the records that were selected in the view and
has already been geocoded. Records that do not have their latitude/longitude updated in the record will
be ignored and will not be plotted on the map.
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Summary card:

Every time the users create a heat map visualization, %
a ‘Summary Card’ summarizing the aggregate
mforrrmatmn for the com-plete heat map will open up. Total Records: 486
This gives the users a brief summary of the heat map
they created. The measure is also summarized by Annual Revenue (Measure): $256368,260.00
default. Annual Revenue (Sum): $256268,260.00
No. of Employees (Sum): 23,400.00
,. % The user can also click on any region plotted on the
map to open the summary card for that region. This

will also filter the data of the region in the data grid.
To differentiate between the summary cards, the
Annual Revenue (Measure): $10,000.00 individual summary cards have the region
$10.000.00 name/number as the title.

Total Records: 1

Annual Revenue (Sum)
0 If the user has selected a field attribute in the ‘Filter’
dropdown, the summary card will further
summarize the information for the selected
category filter as well.

Mo. of Employees (Sum): 2,900.0

Export to Excel: The search results are listed by the grouping selected at the bottom of the screen and
user can further export these data points using this button as shown below;

Jstown ! COUNTRY LANE Keaort Keansburg

9 = G
e Y, Port Monmouth g
Black Horse East Brunswick b Atlantic $0.00 $66.227,773.00

Old Bridge Matawan |A | [ Hide Data Highlands
2 -~ " pwn Uiakinads

My Active Accounts (654) ©OExport To Excel

Account Name Address 1: City Main Phone Territory ndustr Email Created On Annual Revenue

Sandy Hook Bay.

» PostalCode: 10302, NY, Staten Island, USA (Count: 18)
4 PostalCode: 10303, NY, Staten Island, USA (Count: 21)

North - Staten 11/4/2016 12

North - st e 015 1200 A1
This functionality adhere to CRM security roles, if the user does not have permission to ‘Export Data to
Excel’ in CRM, then he/she will not be able to export data from Maplytics.

Zoom Level of Heat Map uses personalized ‘Zoom Level’ setting for the logged in user. Also, the color scale
for the Measure will be fetched from the defined ‘Heat Map Measure Color Scale’ in the Entity Category
configuration on the Entity Map for that particular entity.

Print: Clicking on the print button will print the heat map, as shown in the screenshot below:
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Print
Total: 1 page
Destination SaveisebOF
Change
Pages o Al %
Layout Landscape ¥
4+ More setting:
S000 55078686200
~74.03: ORM=BMLOGO) © 2017 HERE© 2017 Mcrosoft Carporation
"

Note: A4 size paper with landscape mode is recommended while printing.

Support for CDS

If user does not have Dynamics CRM, they can still use Maplytics by subscribing for the PowerApps

platform. This platform comes packaged with some base entities that includes Accounts and Contacts
along with other platform entities to provide support for it security and other infrastructure.

To use Maplytics within PowerApps, user can follow the steps mentioned below:

1. Go to admin.powerapps.com > log in using PowerApps credentials.
2. Click on ‘New environment’ > Enter the details > Create an environment

PowerApps Admin center

Environments Search Q New environment

Environments

NAME -~ TYPE REGION CREATED BY CREATED
Data policies
PHawk Solutions (default) (org92d7d... Default United States SYSTEM 01/16/2019
8o Data integration
PHawk Solutions (peterhawk01) Production United States SYSTEM 01/16/2019

Tenant
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New environment
Create new environments for app and flow development and to maintain
separate databases. Learn more

Environment name

Maplytics

Region (7)

india (default)

Environment type (3)

Trial A

Cancel Create environment

e C(Click on ‘Create database’ > Select the required details > Create database

Create a database for this environment &

Choose the currency and language your data should use.

Currency (7)

You created an environment

Do you want to create a database? wee T
(Recommended) Language (3)

5:?:} Your environment includes access to the English -
Common Data Service. Create a database to
start using it. Include sample apps and data
- Collect, store, and share data
- Use data modeling (D By choosing Create my database, you agree Microsoft can use entity and field

names that you create (but not content in the database tables) to help improve
our common data model. These names may be stored in our diagnostic systems
- Manage security and access to data and copied across regions. Leam more

- Create custom forms

e C(Click on ‘Navigate to other Applications’ > All apps > Powerapps > Select required environment

PowerApps

Search Q New environment

Environments

NAME ~ TYPE REGION CREATED BY CREATED
Data policies
Maplltics (orgdc2! Trial (27 days) United States Peter Hawk 03/11/2019
%o Data integration
PHawk Solutions (default) (org92d7d.. Default United States SYSTEM 01/16/2019
Tenant
PHawk Sclutions (peterhawk01) Production United States SYSTEM 01/16/2019
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PowerApps Admin center ?
|:I Office.com D [ ——— me Q New environment
A~ TYPE REGION CREATED BY CREATED
s (orgdc2999a0) Trial (27 days) United States Peter Hawk 03/11/2019
Solutions (default) (org92d7d... Default United States SYSTEM 01/16/2019
Solutions (peterhawk01) Production United States SYSTEM 01/16/2019
PowerAg r 7 R
ents Search Q . New environment
I~ TYPE REGION CREATED BY CREATED
Add-In
s (orgdc2 Trial (27 days) United States Peter Hawk 03/11/2019

CRM Hub

Solutions (default) (org92d7d.. Default United States SYSTEM 01/16/2019
Dynamics 3

Dynamics 3| [ Solutions (peterhawk01) Production United States SYSTEM 01/16/2019

Flow

PowerAp|

Security & Compliance

Talent: Attract

Talent: Onboard
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Import Maplytics solution
e Click on solutions at the left navigation pane > Import > Maplytics. This will create the Maplytics
App.

PowerApps

G Home Build business apps, fast
M Lean Create apps that connect to your data and work across web and mobile. Learn about PowerApps
B Apps Make your own app
Create T
a
— ¢

B Data ~ - c

& &3, -

o
o™ Business logic

Canvas app from blank Model-driven app from blank Start from data PowerApps Training for Office

All templates —

i PowerApps Maplytics - .
= ;- New solution i Open AppSource [ Publish all customizations [ Switch to classic U3 Selution checker = Al O Search
Home < -
a Solutions
[ Learn Display name Created | Version
P Aees Asset Checkout
Innovation Challenge
Create 9
Fundraiser 3/10/2019 1002
B Data

Comman Data Services Default Solution
o Business logic

Default Solution
£  Solutions

e To access the Maplytics App, click on Apps at the left navigation pane > Select Maplytics App.

PowerApps Maplym )

{1 Open AppSource B Publish all customizations T Switch to classic ¢ Selution checker v = Al L

= + Newsolution € Import

@ Home Solutions

@ Learn Display name Created Version

Maplytics 9040

o Businesslogic

Solutions
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PowerApps
= - Createanapp v ¢ Import package (preview) 3 Microsoft Dynamics 365 L Search
@ Home )
Apps in
@ Learn
Recentapps  Shared withme  Apps|canedit  Org apps
B Apps
Ee Mame Modified Owner Type
Create Bl Maplytics adel-driven
B Data

o Business logic

8  Solutions

Clicking on the Maplytics app, following Maplytics dashboard will open.

= Dynamics 365 v | Maplytics | Sales > Dashboards L2 d 4+ ¥ -
w Vv

= B save As New  SetAsDefault (O Refresh All
@ Home
- @ Maplytics Detail Map v
® Recent v
% Pinned v
S| I =
My Work L JI 2 '

| % Dashboards

Activities
e Pechora (60;

Customers A 4

Accounts f L
CELAND ' . ¢ @
L Contacts

vl FINLAND, RUSSIA

PORTUGAL

\ CHINA
MOROCCO | %3

ﬂ Sales ! PEETR
{ !

<>

o Activate and configure Maplytics
To access the Maplytics user needs to Activate and Configure Maplytics to start the license
and configure the basic Entity maps, Dashboards and Census data.
=  Go to Settings > License registration > Click on Activate
= (o to Settings > License registration > Click on Configure
o Add users to Maplytics team
= (o to Settings > Teams > Maplytics team > Add users
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Note:

1. Entities of leads, Cases, Opportunity, Invoices are not available in PowerApps

2. Marketing lists are not available

Customer Address

4. Only three dashboards will get shipped on configuration

Access Maplytics in PowerApps

While configuring, four Entity maps will get created for Accounts, Contacts, Appointments and

User can use the credentials of the environment to log in to PowerApps and select the Maplytics app to

perform Maplytics features.

b Bing

& View Data

innavative logic
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Maplytics Dashboard

The users can define their Dashboard views for Maplytics and include them as web resources in standard
Dynamics CRM Dashboards.

[ other
[ Partner

Trade Show 3
W Web
[ Blank ’ g

SOUTH SOUTH
AUSTRALIA AUSTRALIA AMERICA

Maplytics ships with five pre-defined Dashboards for various Sales and Service Modules for different user
roles. To set up more dashboards, please refer the ‘Installation Manual’.

Steps to add Maplytics View to Dashboard:

To include the Maplytics component in

Dashboard, click on the new button and select to XVIEEReSOLHJrceEEOpemes '
add Web Resource. Select )

‘ikl_/Maplytics/Maplytics.Dashboard.html’ web

resource and set the name of the Dashboard [~ Web resource

record in the custom data parameter to be passed Web resource™ L e =3

to the HTML web resource.

— Field Name and Properties

Mame* WebResource_MyFollowUpCasesByTodayByPriority

Label * My Todays Follow-up Cases By Priority

Display label on the Dashboard

— Visibility

| Visible by default

— Web Resource Properties
My Todays Follow-up Cases By Priority
Custom Parameter(data)
Restrict cross-frame scripting, where supported.

Pass record object-type code and unique identifier as parameters,
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Create a route dashboard

To plot route on a CRM dashboard follow the steps mentioned below:
1. User needs to include the Maplytics Detail Map component on the Dashboard. To do this click on
the ‘New’ button in the section of dashboard and select ‘Add Web Resource’. Select

‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource.

Go to Sales > Dashboards > Click on “New” button

§8N Dyr 365 v Sales v ¢ >
- _
Sales

My Work Customers Sales Collateral Marketing Goals Tools
@ B e © o
oy 8] > B cvcooss 0
2 B e ] oo o
il
2. Choose any layout as shown below:
Choose Layout x

S Ll =
3-Column 3.Column 4C

Regular Dashbo... Multi-Focused Overview Dashb | I ‘
I h'h 1141

3-Column
Regular Dashboard
2-Column - 2 Calunon 3-Column

e 2-Columy
Regular Dashb

3. Provide the dashboard name and click on the web resource button to add the Detail map HTML
web resource.
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= usT @ WEB RESOURCE > TIMELINE O] IFRAME

INune: * My route Dasnboarg I

7 REL

4, Add web resource

'ikl_/Maplytics/Maplytics.DetailMap.html’ web resource

e

5. Add a parameter in Custom Parameter (data) field as <Dashboard Name>[ |dashboard| [ true

and click on ‘OK’

Add Web Resource 7 %
Add an exsting web resource to the Dashboard
— t %
Neb resource & ik e =
F Narny and F per
ame WebResource, Route

Agpointment FannenDasrdoacinue

6. After saving the dashboard and user can see the route plotted on the dashboard.

innovative logic

imnaGic
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My route Dashboard v

3

MJX2437 DALTON HOUSE 60 \
25 The Mall Road London Londs
250 LINKS ROAD TOOTING LC
190 STREATHAM ROAD MITCH
Macsers M00EN

MNH4659 DALTON HOUSE 60
X WO

\. [ T —

MJIX2476 DALTON HOUSE 60\

53 FARADAY ROAD LONDON 1n
W19 89¢ ENGLAND Y

= LONDON SW17 9€R UK

N e

MACKIOO0 S ST
bmmcn?wmmg- -

Note: Only 25 waypoints can be added into the route.

innovative logic
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Defining Geographies for Sales Territory using Maplytics

The users can create sales territories using the native Dynamics CRM ‘Sales Territories’ feature and define
geographies for the sales territories on a map using Maplytics.

To create geographies for sales territory, go to Settings > Territories and click on ‘New’ to create a sales
territory. With Maplytics a ‘Geographies’ Entity is added on the territory. User can use this feature to
visualize and create geographies for the sales territory. To create a new geography, click on ‘Add New

Geography’.

TERRITORY
Staten Island
General || Define Geography | Territory Map Preview  Related

Geographies

O Refresh

v Name Status Tl

In the section ‘General’, provide a name for the Geography.

\ GEOGRAPHY
/ Postal code 10301

General Map Preview  Related

Mame " Postal code 10301

Territory © [0 Staten Island

Within the section ‘Map preview’, the user has the option to visualize the geography on a map ‘By Region’
or “By Drawing’. The ‘By Region’ option lets the user to plot the geography based on region types and the
user has the freedom to choose the color for the plotted region.
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'/ \‘ GEOGRAPHY
&t/ Postal code 10301

General Map Preview Related

7N e
Search Option
I By Region
Select Region Type

| Postal Code

The ‘By Drawing’ option lets the user to plot the geography by drawing a shape on the map and the user
can further edit the shape based on their needs.

% GEOGRAPHY
7 Drawn shape_Staten Island

General Map Preview Related

R

Search Option

l By Drawing

Define Shapes

OEOOOCUVL®e
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Bulk Geographies by uploading an Excel file

The users also have the option to upload multiple
geographies through an Excel files supported by
CRM using the Bulk Geographies feature in
Maplytics.

K DELETE ~ = EMAILALINK | = EXCEL TEMPLATES ~ ﬁ._, EXPORQ TO EXCEL

al My |mport5 v Create Excel Template

v | Import Name Status Reason Successes Partial F

X
Create template from Dynamics...
ﬂ" Excel Template ﬂ; Word Template
Select data:
Filter by entity . Geography v
Use saved view Active Geographies M
Edit Columns
@ Upload Download File

Name: Name of the Geography.

Create Excel Template

To upload the geographies in bulk, the user
first needs to export an Excel template. Go to
Settings > Data Management > Imports >
select the ‘Excel Templates’ and then click on
the ‘Create Excel Template’ option.

Select the ‘Excel Template’ and in the ‘Select
data’ section, select the ‘Geography’ Entity in
the ‘Filter by entity’ field.

Click on ‘Edit Columns’ and select the below
columns;

Search Option: Bulk geography feature is available only for the ‘By Region’ option, so this value should

always be ‘1"

Color: Color should be in Hexadecimal format i.e. (#DAF7A6). If the user enters the color in other format

then the default color (Blue) will be set.

Edit Columns

Edit columns for the saved view. These columns represent the data that will be displayed in the view.

Name . color |Regicr‘F'Iter | Region Type

Region Value

Search Option Territory Comman Tasks

« >

FF Add Columns

ml

=: Change Properties
R

x[

£emaove
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Region Type: There are 6 region types that the user can define to create the geography. (Country, State,
County, City, PostalCode1l, PostalCode2).

Region Value: If the user needs to create the geography based on Postal Code, then they can define the
postal code values in this column. To define multiple geographies in single territory, use the comma
separator (,).

Territory: This is a lookup value to define which geography belongs to which territory.

Note: For Territory management:
e The column of ‘Territory’ should contain the Names of the territory(ies)
e Color: Color should be in Hexadecimal format i.e. ( #DAF7A6). If the user enters the color in
other format then the default color (Green) will be set.

o There are 8 region types that the user can define to create the geography. (Country, State,
County, City, PostalCodel, PostalCode2, PostalCode3, PostalCode4).

Workflows

Maplytics ships with two different kinds of workflows — Geocoding workflows to geocode addresses and
Territory Assignment workflow to assign territories to CRM records. We also ship a Driving Instructions
workflow to automatically generate directions (in HTML and Plain text format) between two related entity
records using their respective addresses. We ship Geocoding workflow configured for Account, Lead, and
Contact entities and Territory workflow for Account by default. The user can set up these workflows for
custom entities also.

+ My Processes ~
2, New S = 8 K | © actvate @ Deactivate More Actions -

v  Process Mame Category Primary Entity Status
Inogic.Maplytics.GecCoding Worldflow Account Activated
Inogic.Maplytics.GecCoding ‘Workflow Contact Activated
Inogic.Maplytics.GecCoding ‘Workflow Lead Activated

Note: To run the workflow, please make sure the Microsoft Dynamics CRM Asynchronous Processing
service is running as shown in below screenshot.
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File  Action View Help

Reevices

“EhMicrosoft .MET Framework NGEN v4.0.30319_k64

s
1 Microsoft Dynamics CRM Sandbox Processing Service

Microsoft ...,

Automatic (D,

Microsoft Dynamics CRM Marne  + | Description | Status | Skarkup Type | Log On As |
Asynchronous Processing Service 20k Hyper-V Data Exchange Service Provides a ... Started Automatic Local Service
“ELHyper-¥ Guest Shutdown Service Provides a ... Started Automatic Local System
3top the service Z)Hyper-¥ Heartbeat Service Monitors th... Started Automatic Metwork 5.
Pause the service e
Reestart the service L Hyper-¥ Time Synchronization Service Synchroniz...  Started Automatic Lacal Service
“ELHyper-¥ Yolume Shadaw Copy Requestar Coordinate,..  Started Autamatic Laocal System
Description: GRS Admin Service Enables thi,,,  Started Autamatic Lacal System
Handles the processing of queued “ELIKE and AuthIP IPsec Keying Modules The IKEEX...  Started Autamatic Local System
Asynchronous Events Gk Indexing Service Indexes co,.. Started Automatic Local System
L Inkeractive Services Detection Enables us... Maral Local Syskem
Gk Inkernet Connection Sharing (1C5) Provides n... Disabled Lacal System
‘L Inkersite Messaging Enables me... Started Autamatic Lacal System
“GLIP Helper Provides tu... Started Autamatic Lacal System
L IPsec Policy Agent Internet Pr.,,  Started Manual Metwork S,
“ChKerberos Key Distribution Center On domain ... Started Autamatic Lacal System
“ChKtmRm Far Distributed Transaction Coordinatar Coordinate. .. Manual Metwork S...
“ChLink-Layer Topalagy Discovery Mapper Creates a ... Manual Local Service
“EkMicrasoft .MET Framework NGEN v2.0.50727_K64 Microsaft . Disabled Local Syskem
£k Microsoft .MET Framework NGEN v2.0.50727_k86 Microsoft ..., Disabled Local Syskem

Local System

andies th., .
Handles th...

TErTE
Started

Jati 134 o

Automatic (D,

TIETRIGTR.
Metwork S,

Steps to Configure Geocoding workflows for custom entities

1. Go to Setting > Processes > Click on ‘New’ to design a new Workflow Process.

2. Write Process name, choose ‘Workflow’ under category section and select desired entity as

shown below;

Create Process
Define a new process, or one from an exi
actions, dialogs, and workflows.

Process name: ¥ Maplytics.GeocCodingWorkflow

‘Workflow T

Run this workfiow in the background (recommended)

#)| New blank process
MNew process from an existing template (select from

Type:

Account

. You can create four kinds of processes: business process flows,

Cance

innavative logic
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3. Select ‘Organization’ under ‘Scope’ dropdown. Select ‘Record is created’ and ‘Record fields

change’ options as shown below:

[ ‘ Process: Inogic.Maplytics.GeoCoding
ES %, Information
Genera Administration ~ Notes
4 Common
T, Information

[ Audit History

w Hide Process Properties

Process Name * nogic.Maplytics.GeoCoding

4 Process Sessions
[ Process Sessions Activate As Process v

Available to Run

#| Run this workflow in the background (recommended)
#| As an on-demand process

As a child process
Workflow Job Retention

# Automatically delete completed workflow jobs (to save disk space)

Entity

Category Viorkfiow

‘Working on solution:

Options for Automatic Processes
Scope Organizatio
Start when: ¢ Record is created
Record status changes
Record is assigned
¢ Record fields change Viev

Record is deleted

4. For the Record fields change option, select all of the address fields to ensure the address is
geocoded when any of the address fields is changed as shown below;

Select Fields

Select the fields that the process will monitor for changes.

Display Mame a MName Type
Address 1: Shipping Method address1_shippingmethod.. Option Set
#| Address 1: State/Province address1_statecrprovince Single Line of Text
¥ Address 1: Street 1 address1_linel Single Line of Text
#| Address 1: Street 2 address1_line2 Single Line of Text
¥ Address 1: Street 3 address1_line3 Single Line of Text
Address 1: Telephone 2 address1_telephone2 Single Line of Text
Address 1: Telephone 3 address1_telephone3 Single Line of Text
Address 1: UPS Zone address1_upszone Single Line of Text
Address 10 UTC Offset address1_utcoffset Whole Mumber
o Address 1: ZIP/Postal Code address1_postalcode Single Line of Text
Address 2 addressZ_composite Multiple Lines of Text

-

4 Cance

(o) MRS &P MapLYTICS"

Page 115 of 145




Maplytics™ — User Manual

Note: Please don’t select Latitude & Longitude field attribute here.

5. Select the Inogic.Maplytics.Geocoding workflow assembly from the Add step menu as shown
below;

Process: Inegic.Maplytics.GeoCoding ‘Working on solution: Default Solution

LE,\ Z, Information

Genera Administration Notes
4 Common

Z. Information

@ Audit History

4 Process Sessions ~ Check condition for Geocode Record

[& Process Sessions it
Account:Geocode Record does not contain data
AND
{Account:Address 1: Street 1 contains data OR AccountAdaress 1: City contains data OR Account:Address 1: State/Province contains data OR AccountAdaress 1: ZIP/Postal Code contains data OR Account:Address 1: Street
2 contains data OR Account:Address 1: County contains data OR Account:Address 1: Country/Region contains datal, then:
# Setaddressinput parameter to calculate the geocode.
Incgic.Maplytics.Geocoding (5.4.0.5:GeoCodeWorkflow.GeoCodeAddress View properties

# Set calculated Latitude and Longitude in selected record.
Update: Account View properties
Othenwise, if
Account:Geocode Record equals [No]
AND
{Account:Address 1: Street 1 contains data OR Account:Address 1: Street 2 contains data OR Account:Address 1: City contains data OR AccountAddress 1: State/Province contains data OR AccountAddress 1: County
contains data OR AccountAddress T: Country/Region contains data OR AccountAdaress 1: ZIP/Postal Code contains dats), then:
# Setaddressinput parameter to calculate the geocode.
Inogic Maplytics.Geecoding (5.4.0.5):GeoCodeWorkilow.GeoCodeAddress View properties

#  Set calculated Latit

and itude when Geocode Record is equal to No.

Update: Account View

Status: Activated

Note: For custom workflows, add an 'AND' condition, if the address fields are not blank as shown in the
above screenshot. This will avoid the trigger of the workflow if the address fields do not have any value.

6. Click on ‘Set Properties’ and set the address parameter as shown in below screenshot for the
workflow assembly;

n 3 save and Close
Process: Inogic.Maplytics.Geocoding

Ll Set Custom Step Input Properties

Property Mame Data Type Value
Streetl Single Line of Text {Bill To Street 1(Invoice]}
Street? Single Line of Text {Bill To Street 2(Invoice]}
Street3 Single Line of Text {Bill Ta Street 3({Invoice]}
City Single Line of Text {Bill To City(Invoice]}
StateOrProvince Single Line of Text {Bill To State/Province(lnvoicel}
County Single Line of Text
Country Single Line of Text {Bill To Country/Region|lnvoicel}
PaostalCode Single Line of Text {Bill To Street 3({Invoice]}
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7. Choose ‘Update Record’ from ‘Add Step’ menu after selecting ‘Set Properties’ record and select
same entity for which workflow is being created.
8. Click on ‘Set Properties’ of the new record and in the update window set the Latitude, Longitude
and Rating to the output parameters returned by the workflow assembly as shown in the

screenshot below;

Latitude
Longitude
Rating

{Latitude{5et address il
{Lengitude(Set addres:

{Rating{5et address ing

User can also check the geocoding confidence rating provided by Bing Maps. A ‘Rating’ field can be added
that shows the confidence rating as High, Medium or Low. The ‘Rating’ field is set in the workflow as
shown in the above screenshot.

©

<« Map

No Auto Geocoding

Street 1

Street 2

Street 3

City
State/Province
ZIP/Postal Code
Country/Region
Latitude
Longitude
Rating

Territory

No

3649 at HYLAN BLVD

10308

Staten Island

NY

usa

40.54925

-T4.13820

Medium

Note: Latitude and Longitude fields should of data type: ‘Floating Point Number’ with precision set to 5.
Add minimum to maximum range of fields respectively Latitude (+90 to -90), Longitude (-180 to +180).

innovative logic
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Steps to Configure Territory Assignment workflow for custom entities:

©

imnoGic

1. Follow the Steps 1 — 3 from configuring
geocoding workflow for custom entities.
This will help you create a new workflow.

2. For the Record fields change option, select
all of the address fields to ensure the
territory is changed when any of the
address fields is changed as shown below;

Select Fields x

Select the fields that the process will monitor for changes.

Display Name a Name ype
Account Name Single Line of Text
sing|

Option Set

Account Mumber ne of Text

Account Rating

o A 1 Multiple Lines of Text
s A 1: Address Type Option Set
oA 1: City Single Line of Text
oA 1: Country/Region Single Line of Text
o A 1: County Single Line of Text

A Sing| ne of Text

A reight Terms Option Set
oA 1: Latitude Floating Point Number

o

OK Cancel

3. Click on ‘Add Steps’ and add ‘AssignTerritoryWorkflow.AssignTerritory’ assembly as shown

below;

Process: Inogic.Territory.Assignment.Workflow
Lg*l Z. Information

Genera Administration Notes

‘Working on solution: Default Solution

4 Common
. Information
@ Audit History

~ Hide Process Properties

- Process Name * Inogic.Territory.Assignment.Workfiow
4 Process Sessions

[ Process Sessions

Activate As Frocess v
Available to Run
Run this workflow in the background (recommended)
#| As an on-demand process
As a child process
‘Waorkflow Job Retention

#| Automatically delete completed workflow jobs (to save disk space,

B3 Add Step + | Sealnsert + 3¢ Delste this st
Assign Record .
Send Emai
Start Child Workflow
Perform Action
Change Status
Stop Werkflow
WoC N
Inogic.Maplytics. AssignTerritoryWorkflow (1... »

Inogic.Maplytics.Geocoding (54.04) 3

Status: Draft

Entity Contact
Category Workflow
Options for Autematic Processes
Scope Organization
Start when: ¥| Record is created
Record status changes
Record is assigned

| Record fields change

Record is deleted

AssignTerritoryWorkfiow.AssignTerritory

innavative logic
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4. Click on ‘Set Properties’ and set the address parameter as shown below and Save this;

-l Set Custom Step Input Properties - Microsoft Dynamics 365 - Google Chrome = B “

& https//maplyticsdemo56.crm.dynamics.com/

ey Seve and Close @ep -
ile

fj Process: Inogic. Territory.Assignment.Workflow ‘Working on solution: Default Solution
% set Custom Step Input Properties

Property Name Data Type Required Value Form Assistant 3
Latitude Floating Point Num.. Optional {Address 1: Latitude(Contact)} Dynamic Values M
Dynamic Values -
Longitude Floating Point Num... Optionai {Address 1: Latituge(Contact])
Operator:
setto v
Look for:
Contact v
‘Address 1: Latitude v
X |t B
‘Address 1: Latitude(Contact)
Default value:

Steps to Configure Driving Instructions workflow

1. Go to Setting > Processes > Click on ‘New’ to design a new Workflow Process.

2. Write Process name, choose ‘Workflow’ under category section and select desired entity as shown
below;

Create Process

Define a new process, or create one from an existing template. You can create four Kinds of processes: business process flows,
actions, dialogs, and workflows.

Process name: * GetDirection

Category: * Workflow ¥ Entity: * . v

#| Run this workfiow in the background {recemmended) m

L ® Mew blank process Account Li“

e Mew process from an existing template (select from list): Actuz
Actual Data Export (Deprecated)
Address
Agreement
Agreement Booking Date
Agreement Booking Incident
Agreement Booking Product

Template Name 4 Primary Entity
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3. Select ‘Organization’ under ‘Scope’ dropdown. Select ‘Record is created’ and ‘Record fields change’
options as shown below;

Vo kirey on wolutesr |

:1. » o]
gy
i 0 it PYaes
ol Bl wirfEw A B BlShEraut [Rer Sded
o .
Ag ¥ O [udeic
Erat wibue g F copabed
i il s
= M CragE
WodkFiow bob Eatesins
¥ AAcatiny dewly competed workfo ror ace

4. For the ‘Record fields Change’ option, .
) Select Fields x
SeleCt a“ Of the address fIEIdS to ensure Select the fields that the process will monitor for changes.
the address is retrieved when any of the
address fields is changed as shown below;

Display Name & MName Type
Address 1: Shipping Method address1_shippingmethod... Option Set -
#  Address 1: State/Province address1_stateorprovince Single Line of Text
|  Address 1: Street 1 address1_linel Single Line of Text
#  Address 1: Street 2 address1_line2 Single Line of Text
#  Address 1: Street 3 address1_line3 Single Line of Text
Address elephone 2 address1_telephone2 Single Line of Text
Address 1: Telephone 3 address1_telephone3 Single Line of Text

Address 1: UPS Zone Single Line of Text
Address 1: UTC Offset
#  Address 1: ZIP/Postal Code

Address 2 address2_composite Multiple Lines of Text

Whole Number

Single Line of Text

OK Cancel
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5. Select the Inogic.Maplytics.Drivinglnstructions workflow assembly from the Add step menu as shown

below;

Genera Administration MNotes

» Show Process Properties

B2 Add Step ~ j’ﬂlnsert v X Delete this step
Stage

Check Condition

Conditional Branch

Default Action

‘Wait Condition

Parallel Wait Branch

Create Record

Update Record

Assign Record

Send Email

Start Child Workflow

Parform Action

Change Status

Stop Workflow

IrogicMaplytics. AssignTerrtoryWorkflow (1.
Inogic.Maplytics.BulkGeoGraphies {1.0.0.0)

InogicMaplytics. Geoceding (5.4.0.4)

]

Inogic.Maplytics, Drivinglnstructions.Drivinglnstru... I

Inogic.Maplytics. Bty ighe eyt (1.0.0.0)

6. Click on ‘Set Properties’ and set the address parameter as shown in below screenshot for the

workflow assembly;

B3 Add Step ~ jﬂilnsert - )( Delete this step.

& Get the Directions information

Inogic.Mapilytics.Drivinglnstructions {1.0.0.0):Incgic.Maplytics.DrivingInstructions.DrivingInstructions I Set Properties

Process: GetDirection
E'“}J Set Custom Step Input Properties

Property Name | Data Type | Required
FromAddress Single Line of Text Required
ToAddress Single Line of Text Required
TravelMode Single Line of Text Optional

DistanceUnit Single Line of Text Optional

innovative logir
(o) ST

| Value

{Address 1: Street 1(Account)} { ~
{Address 1: Street 1(Primary Co =
Driving

Mile

6@ MAPLYTICS™

‘Working on solution: Default Solution

Form Assistant

Dynamic Values |
Dynamic Values -

Operator:

Setto v
Look for:

Primary Contact (Contact) v

Address 1 v

Add
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In ‘FromAddress’: Select the address fields of the entity that you want the direction ‘From’. Select
the all address field i.e. Steetl, Street2, and City etc. and ensure sure you keep space between
two fields.
{Address 1: Street 1(Account)} {Address 1: Street 2(Account)} {Address 1: City(Account)} {Address
1. State/Province(Account)}

In ToAddress: Select the address fields of the entity that you want the directions ‘To’. Select the
all address field i.e. Steetl, Street2, and City etc. and ensure to keep space between two fields.

Travel Mode: Select the Travel mode. For example (Driving, Walking, Transit). If you do not specify
the Travel mode then it will take Driving mode by default.

Distance Unit: Select the Distance unit. For example (Mile or mi, Kilometer or km). If you do not
specify the unit then it will take Kilometer as default unit.

7. Click on add step -> Send Email -> Click on set property

©

PowerApps

H ) saveandciose 0 | @ acvate | (S Convert to 2 background workflow | =33 Show Dependencies Wy Actions + @Hep -
ile .
Process: Dire ction Working on solution: Default Solution
Lg" Z. Information

Genera Administration Motes
4 Common

&. Information [ Add Step | ZSinsert~ K Delete this ste
Audit History
=2 ! Stage
4 Process Sessions
= Check Condition
[ Process Sessions Slytics Drivinglnstructions.DrivingInstructions | Sel Properties
Create Record ties
Update Record

Assign Record

Send Email

Send Email
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. . i“: . . .. .
8. Click on Email body -> Select Look for -> local value “inogic.Maplytics.Drivinglnstructions.
.. . ”
Drivinglnstruction
ol Email: New Email - Microsoft Dynamics 365 - Google Chrome = B
@ https://map208.crm.dynamics.com/SFA/Workflow/entityfon 28entityFullName=email8entityname=email&stepld=CreateStep2 &workflowld =5ffad3a5-d...
Il saveanc Close @rep -
l—J Process: Dire ction
Create Email
Form Assistant >
From B ) |8 % | | wereacons -
~ - o - Dynamic Values v
o {Account(Registration Proccess)} File Name 4 'T) Dynamic vales -
«
a Operator:
Bee = Setto v
- Look for:
Subject » InogicMaplytics Drivinginstruction Y
= Primary Entit,
B I U = 4 A A 22 0 -0 of 0 (0 selected) M4 Page r::;g,ﬂ:g‘ny,,mﬁs

Related Entities
Account [Accor

Aaplytics Driv;

{DrivingInstruction(Inogic ns Drivinglnstructions)

Created By (Us
Currency iCurr

Owring Team
Local Values

Process

Created By [Delegate] (User)

Medified 8y (Delegate) (User)
Modified By (User]
Owning Business Unit (Business Unit)

Owning User (User)

uni)

er)
ency)

(Team)

Regarding

Duration

FEAD)

Select DrivingInstruction for plan text or DrivinglnstructionHTML for html page.

Click on save and close.

The driving instructions will

be returned both in HTML

From Address: 1 NW S0th Ln Ocala FL 34482 USA
and Plain Text format as an |i°m'“*=435°“ﬁ Frosiproo! FL 35843 USA
. otal Travel Distance: 208.45 milas
OUtpUt paramEter to thls otal Travel Duration: 3 hrs 25 min
workflow. User can use Lnstruction Distance
. Depart NW 50th Ln toward NW 115th Ave 0707
either of them. For example i N T s —
we have used HTM L [Turn right onto NW Highway 4648 / CR-464B 1.652
[Keep straight ante NW 110th Ave 127
formatted direction Turn right onio US-27 S/ SR-500 S 11.539
. . . . [Take ramp right for 1-75 South toward Tampa 140.409
instruction in Email here. At cxit 328, take ramp left for Florida's Turnpike South toward Orlanda | mp—
[Turnpike e
At cxit 289, take ramp nght for US-27 toward Cleremont / Taveres 70.493
[Turn left onto W Main St/ CR=17 2.715
[Turn right onto 10th St N |
[Road name changes 1o US-27 ALT ) SR-17 / 10th 51§ [0.a55
ITum left to stay on US-27 ALT / 5R-17 / E Main 5t 18.945
At roundabout, take Znd exit 16.91
[Bear right onto McLeod Rd o352
Keep straight onto N Palm Ave 1,992
[Turn left onto W 1st 5t §0.202
|Ammive at Frostproof, FL u

innovative logic
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Maplytics Batch Processing Tool

The workflows for Geocoding and Territory Assignment designed can be used on a day-to-day basis for
addresses that are changed or added occasionally. However, for bulk geocoding/territory assignment on
data, we recommend using the Batch Processing tool. This tool ensures that the bulk geocoding on records
is handled in single batch. While in the territory assignment, this tool helps to assign the respective
territories to all the selected records based on their Latitude and Longitude values.

Note: To run this tool, the user needs to make sure that machine has Microsoft .net framework 4.0
and Maplytics installed in Dynamics CRM.

To run the tool, Extract the Batch - ]
) . . Name Type Compressed size
Processing tool .zip file and run the
. f f = BatchP ingTool Applicati 104 KB

BatchProcessingTool application. Frenriacessng oo peicatien
|| BatchProcessingTool.exe XML Configuration File 1 KB
%] Microsoft.Crm.Sdk.Proxy.dll Application extension 38 KB
%) Microsoft.ldentityModel.dll Application extension 360 KB
%) Microsoft.Xrm.5dk.dll Application extension 146 KB

Executing Batch Processing Tool:

Connection Details:

Please enter the CRM details on this screen. The users have to enter the following details:
Deployment model: The user can select either of the options given in below screenshot
depending on their deployment.
CRM Server: Please enter the serverurl of CRM. For example, http://<servername>:<port> or
https://<orgname>.crm.dynamics.com
Organization: If the deployment model is ‘OnPremise’ then the user has to specify the
organization name. For other deployment models leave this blank.
When the user enters the server URL in case of On-Premise deployment model, the organization
list will be auto-populated with the organizations available in CRM. Select the organization for
which Maplytics is to be or already has been installed.
Username: Username of a valid CRM user. For example: mollyc@CRM166504.onmicrosoft.com
In case of On-Premise deployment model, the organization list will be auto-populated with the
organizations available in CRM. Select the organization for which Maplytics is to be or already has
been installed.

Password: Password of CRM user.
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@ Maplytics - Batch Processing Tool (2.0.0.8) - D

Maplytics Batch Processing

Choose Option: Here, the user can make selection whether they would like to run this tool for Geocoding

(Batch Geocode) or Territory Assignment. In this example, we have chosen Batch Geocode as shown
below:

© Maplytics - Batch Processing Tool (2.0.0.8) - o

f; ©  Maplytics Batch Processing
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Entity Selection and Filtering:
Please find the details of the same below:
e Entity: Select the entities on which the user would like to run this tool.
e Views: Once the user selects the entity, all the views defined for this entity are populated in the
list of views. Select the required view.

@ Maplytics - Batch Processing Tool (2.0.0.8) - o

‘; ©  Maplytics Batch Processing

My Open Leads W

Add

Entity Name View Name
Account Active Accounts
Lead My Open Leads

Results and Log Settings:
Since this is executed as a batch process in the background, enter the email address, if the users would

like the job results to be mailed to them.
© Maplytics - Batch Processing Tool (2.0.0.8) - o

f; ©  Maplytics Batch Processing
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Progress :
In this section, the user can see the progress of the geocoding process.
@ Maplytics - Batch Processing Tool (2.0.0.8) = =

f @
y®

Maplytics Batch Processing

Fetching geocode data from Bing map

Record Summary:

Geocoding:

Bing Status: This shows the number of the records for which the geocoding from Bing maps were
successful or failed.

CRM Status: This shows the number of the records for which the updation of geocordinates (Latitude &
Longitude) to the respective CRM records were successful or failed.

After completing the geocoding process, the user can download the results. The results will be

downloaded in CSV format. User can check the columns of CRMDescription and BingDescription in the
result to check the reason for failure of processes on the records.
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@ Maplytics - Batch Processing Tool (2.0.0.8)

f,’, ©  Maplytics Batch Processing

Records Summary
Total processed reco

Bing Status

Account
Lead

CRM Status

Account
Lead

Territory assignment:

View Name

Succeeded

Active Accounts

1044

My Open Leads

View Name

1044

Active Accounts

Go to Home

Download the results Finish

CRM Status: This shows the number of the records for which the updation of Territories for the respective

CRM records were successful or failed.

f,’, ©  Maplytics Batch Processing

Records Summary
Total 2088
CRM Status

Total Align Records :

View Name

@ Maplytics - Batch Processing Tool (2.0.0.8)

. o

My Open Leads

Active Accounts

Go to Home

Oz &rwwurmcs-

Download the results Finish
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Note:

1. If a user selects ‘All records’ for an entity, then a view for that entity cannot be selected.
2. Auser cannot select an entity with a same view twice.
3. If the user adds an entity with a view and then selects ‘All Records’ for the same entity, it will

remove all the views selected for that entity with the user’s permission.

4. All of the above instructions apply for running Batch processing tool for Territory

Assignment.

Pre-defined colors for Categories

The users now have the ability to define colors for the categories of the plotted records. To define the
color of the category attribute, the users have to follow the below steps:
Go to Settings > Entity Maps and select the entity map of the entity for which the user needs to

@il‘lDEiC

define the color.

ENTITY MAP
account

General  Attribute Mappings  Tooltip Mapping

Entity Name * [Account |

B Total Records 741

& Geacoded Records 715

Click on the plus (+) icon of the Category
Configuration subgrid to open the new Entity
Category form. Select the name of the category
attribute in the Category text box and save the form.
The user can select only OptionSet, Two options,
Numeric, String, Lookup and Money attributes to
define category colors.

Colors and shapes will be auto-populated, the user
can set their own preference.

The user can click on the 24 AutoSet button to set
random colors as well as shapes for all the values, or
the user can click on he Discard button to cancel the
changes.

innovative logic

Category Configuration  Configuration

ﬁo MAPLYTICS™

Advance Settings

Related

Link To [

Create New Record Yes

ENTITY CATEGORY : INFORMATION

revenue =

» General

4 Category Mapping

Range List

Start Range End Range

o
o
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Maplytics — Tablet / Mobile

For Dynamics 365 v9.x, Maplytics can be accessed from the Entity homepage and entity form using the
‘Detail Map’ , ‘Heat Map’ and ‘Map’ button respectively.

. My Active Accounts

| +  New
i Delete
O Refresh
& Detail Map
& Heat Map
&g Email a Link
o Flows

g1 Export to Excel

&1 Open Dashboards

-1
. +1-695-555-3400

ABC

@ Delete

Shew Chart +  New

Detail Map

| Account Name T

-1

Johnson County Museum of History

Tailspin Toys

Trey Research

Il # A B C D E F G H

1-9 of 9 (0 selected)

Main Phone  T) | Address 1: .

1-555-555-0135 1 Microsoft W...

+011-1-399-555 Mississaugua
+1-674-555-016 -
+1-695-555-340 ---
317-7364655 Johnson
297-555-0192 Tokyo

+49-(0)89-0110- Munich

J K L M N (o]

71| Primary Contact 1
Isaac Lightner
Shaun Beasley

Cat Francis

Marco Tanara
Humberto Acevedo

P Q R S T u

Email (Primary Contact)

isaaclightner@onemi...

info@fineartschool net

Cat@cohowinery.com

mtanara@tailspintoys...

info@treyresearch.net

v w X Y z

Mobile

Tablet

Contact: Contact
@ Benno Kurmann + New  [3 Deactivate [ Delete Refresh
[& Deactivate Contact: Contact ™~ Crwner
) Cat Francis
8, Assign @ o Test Map 2
= Email a Link
M Delete Summary Map Details Related
() Refresh
| CONTACT INFORMATION Timeline +
& Map
First Name T Ccat Enter a note. B = & 0
2 Process
Middle Name -
¥ Follow OLDER @
Last Name *  Francis
+*  Flows e Auto-post on Cat Francis's wall - 21 de marco de 2018
03:41
— Job Title Purchasing Manager
Contact: Created By Jamie Reding (Sample Data)
Last Name * Company Name -1 yel
Kurmann @ Like “ Reply
Emnail Cat@cohowinery.com =7
Job Title
<« = & p g < = @ g ) Q
innovative logic ™
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Maplytics can also be accessed from the Dynamics 365 App for Phones and Tablets (both on Dynamics
365 v8.2 and v9.x) using a dashboard for detail map. To open Detail map; Go to Dashboard > Maplytics
Detail Map as shown below:

Q Maplytics Detail Map v

M % Maplytics Detail Map

vice Manager Dashbo

vew Bot Dashboard

RUSSIA

Pan Vo

(4 KAZAKHSTAN

o =) L
Ry ’\,?"‘.5\'5“}‘,:@; _,>f
A P \\r&mla’sr{rv

g\ . ‘_1/_, » }'?\'t\\,~'

ks = ® pe)

Q

{

CH
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System Dashboards

| ¥ Maplytics Detail Map

v Set As Default () Refresh All

6 Maplytics Detail Map v~

Maplytics Heat Map

Maplytics Overview Dashboard

Maplytics Sales Activity Dashboard
¥ Maplytics Sales Performance Dashb.
% Maplytics Service Manager Dashboa

My Dashboards

¥ New Bot Dashboard

SWEDEN
|

| FINLAND/
NORWAY,

North
Sea
uniTEp  CENMARK oy
_KINGDOM -
fand | BELARUS S
gl GrrmANy POLAND | .
“4 UKRAINE

FRANCE,

T B
i

RUSSIA

KAZAKHSTAN

R (%]

MONGOLIA

Q

Sea of Dkhor

Detail Map: The Detail map consists of the following components.
Plot: There are five ways to plot the data on Map, similar to the Detail Map on browser;

e By Location
e By Region

e By Drawing
e By Territory
e By Template

Proximity:

Enter the radius for the proximity search. The Proximity can be provided in either Miles or Kilometers.

innovative logir
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T

Qe0or  &roi

ops at

9% DIRECTION

‘ Y Layer Menu

Plot Records
O cluster map
Search Option
| By Location

Current Location
222 at STH AVENUE Manhatian NY | @
Proximity

O Distance O Time
(O show Travel Distance

1 ' Miles
Select Datasource
ot i 0 ooce I
+
Select Category

|setctcal |

Select Overlay

Select Overlay

oo Tmies 1km

= Adeipii
‘“gémmznuznwmmmmmmwm -

A

"SI
e

V' Ty
LPPIL BANT HiDL

i

Kare Y Tpo Y Cwmer Y SaksRexcn Y CaaledOn Y ComponyMa.. Y | UneolSght.. Y Frodmzy Zone Y
a | Ying Bhigams  Buny Profucts  AwbhavGhap . New 270672019 52 129 223
a | Yostvo Cizkor Enctronkcs Nabtav Ghop. Cortazied 2TN6R018 32 0.2 '
a | Zara Kigeedod Real Estive Vabtav Ghop . New 2062008 2. 081
{3 | Wty Awat Eloctionics Vabhav Ghom... | Contacled 2702019 32 L '

N n: & v hemsgerpage 160 of 100 hems

Summary Card:

Now users can also get the aggregated information for a particular closed shape on the map with Summary

Card.

@m'n"ﬁ"&"lg
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Lynnwood,
Edmonds @
Kingston Mountlake
@pLor | &pol | 9 DIRECTION LS Tersce  \ 7
Por Richmond )
- adon Shoreline. Highlands; - Bothell<
IR l
£} Layer Menu e
- w8
= Puget Sound
| Plot Records X
3
%  seattle USA
¥ seattle USA w Bainbridge
v ) Total Records: 16 e Bellevue Sammamish
Total Records: 15 N i‘\# > | )
\J\‘»,l.\ L Account - (All Accounts): 16 g o)
d : M
Account - (All Accounts): 16 S ‘% f Annual Revenue (Average): uf.'ﬁﬁ'
Annual Revenue (Average) .') €, e"“ ¥11,875,000.00 B S l”
¥11,875,000.00 L ( VL No. of Employees (Sum): 190.00 ;'\
No. of Employees (Sum): 190.00 P4 [ o ’ o £ 5 s, - ‘Mount Si
“e» State Forest
MRS " Repfon
Redmond USA 2 Normandy Park
[ B A
. oy
. (16) ( { Moty
T¥and
] Coyigton
Account Name Y | Main Phone Y  Address 1: City Y  Primary Contact Y Emailv Y Status Y
% City Power & Light As... | 425-555.7824 Seatlle Darren Parker darren.parker@wood... | Active
% Contoso Pharma Ass. 206-555-5131 Seattle Cheri Castaneda cheri_castaneda@fab. Active
% Fabrikam West 206-555-4078 Seattle Cheri Castaneda cheri_castaneda@fab... = Active
. \ . & (e » M 50 v items per page 1-16 of 16 items
Artondale\, "£a010 HERE £ 5810 b esnsot Comaraicn Tl J

Search POI:
Ability to search for any Points of Interest (POI) like ATMs, restaurants, hotels, coffee shops, etc. in the
vicinity. This will be plotted alongside the CRM data.
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Category Filter: User can categorize the data on the basis of an attribute of the Entity
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Current Location:

This is used in combination with Proximity to specify the center point for the proximity search. By default,
this field displays the address stored in the Maplytics Personalized record of the logged in user.

Set GPS Location as the current location:
The user can also locate the GPS location of phone/tablet devices using ® button.
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GPS location is represented by ‘Blue’ circle on the map. It will automatically update the user’s current
location, making it easier to perform proximity (Near-Me) searches.

Note: Please ensure the following points for the GPS functionality to work:
e Provide ‘Location’ permission to Dynamics 365 App in phone / tablet device
e GPS location is turned ON of respective devices
e ‘User Content and Location’ is tuned ON in Dynamics 365 App

Tooltip:
Every Pushpin will display the record name, address, as well as the contextual data defined in the tooltip

section of the Maplytics Configuration. The user can open the record, change owner and run workflow
using the available quick actions button.
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Contextual Menu:

To get a contextual menu on the map, long press anywhere on the map. Pushpin Contextual menu
provides the following additional options. These option provides commonly used features in Maplytics
like Set as Current Location, Origin, and Adding to Route, etc.
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Selecting this option will set the address of the pushpin as the start location of the route.

Set As Destination:

Selecting this option will set the address of the pushpin as the end location of the route.

Add to Route:

@Iﬂigvik&k
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This option will set the address of the pushpin as a middle waypoint of the selected route. For example, if
the users already have Point A and Point B selected as their route, and click on the Add To Route option,
then the Point B will become Point C, and the address of the selected pushpin will become the Point B of
their route.

Set As Current Location:

This option is used to set the address of the pushpin as the current location, which can be used for
proximity search. For example, if the user wants to plot all the leads that are within a radius of 100 miles
from a particular record then the user can click on the Set As Current Location option to set the address
as the current location and then the user can plot the records around this location.

This option also removes the additional step to type the current location manually for the proximity
search.

Set As POI Location:

This option helps the user to set the center point for the Point of Interest (POI) searches like ATMs,
restaurants, Airports, etc. Once this location is set as the POI location, the user can search for different
POI around this location.

Manage Territory:

The user can manage the territory, i.e., assign/re-assign territory from the map using this option.

Save Template:

User can save the plotted search criteria as a template, so as to open the template directly instead of
searching on the map again.

Save The Template

Save The Template

Add to existing template

O Add to existing template

L]
Create new template © Create new template

Please enter the template name.

Access Level Access Level

Personal
Personal
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Routing — Tablet / Mobile

Another essential feature of Maplytics is Routing across multiple waypoints. Using the Contextual Menu
options explained above, the users can add multiple waypoints to their journey. At given point in time,
the users can add maximum 25 waypoints in direction.
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Once multiple waypoints have been added, click on Go button to bring up the Routing Screen shown
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When the user plots the data and then creates a route, both the plotted data and the route will stay on
the map. This makes it easy for the user to add more waypoints to the route without switching between
Plot and Directions card. The route can be cleared using the ‘Clear Route’ button.
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Save Route and Plot Saved Routes:

Users can now save the route from the Dynamics 365 App for Phones and Tablets and later use the ‘Open
Saved Route’ feature to plot the saved routes.

Save The Route

_ Add to existing route

® Greate new route *

Follow up route 2

Select route date *
2019-07-22
Owner

Dev H

@ih‘gi%“i%

Save The Route

© Add to existing route

© Create new route *
Follow up 3

Select route date *

2019-07-22

Owner

DevH
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Email route - The user can email route to any of the
Dynamics CRM records using email route option.

Along the Route Search:
The user can also search the along the route records the same way as on the Browser.
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Route Redirect and Copy Navigation Links:

Redirect with Google Maps

Navigation Links
For turn-by-turn navigation, please use the
following links

Show Complete Route

From: Leontine Mastropietro
To: Therese Zelenka

From: Therese Zelenka
To: Mack Buettner

From: Mack Buettner
To: Sybil Silverman

& Copy Links

innovat

@ino

&ic

Navigation Links
For turn-by-turn navigation, please use the
following links
Show Complete Route

Froen: Gabeiel & Sons.

To: Khani & Sons

From: Khani & Sons
To: Halablan & Sons

To: Mohammad & Sons

6@ MAPLYTICS™
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Redirect with Waze

Navigation Links

For turn-by-turn navigation, please use the
following links

From: Current Location
To: Leontine Mastropietro

From: Current Location
To: Therese Zelenka

From: Current Location
To: Mack Buettner

From: Current Location
To: Sybil Silverman

& Copy Links

Manual

Navigation Links

For turn-by-turn navigation, please use the
following links

From: Current Location
To: Gabriel & Sons

From: Current Location
To: Khani & Sons.

From: Gurrent Location
To: Halabian & Sons

From: Current Location
To: Mohammad & Sons

Heat Map — Tablet / Mobile

For Dynamics 365 v9.x, Maplytics can also from the Entity homepage and entity form using ‘Heat Map’.

When clicked on Heat Map button, it opens the heat map.
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Summary card:

Heat Map
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Summary Card X : s
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Column chart in Heat Map
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Dashboards — Tablet / Mobile

The users can define their Dashboard views for Maplytics and include them as web resources in standard
Dynamics CRM Dashboards.
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Maplytics ships with 6 pre-defined Dashboards for various Sales and Service Modules for different user

roles.
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Contact Us

M/S. INOGIC TECH (INDIA) PVT. LTD.

A-301 Everest Nivara InfoTech Park,
MIDC, Turbhe,
Navi Mumbai - 400 705 - INDIA.

E-mail: crm@inogic.com
Twitter: @Maplytics; @Inogic
Facebook: @Maplytics; @Inogic

Website: http://www.maplytics.com/ ; http://www.inogic.com/
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